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Εισαγωγή

Η διείσδυση του ηλεκτρονικού υπολογιστή στην καθημερινή μας ζωή είναι αναπόφευκτη και έχει φτάσει σε μεγάλο ποσοστό. Ιδιαίτερα χρήσιμοι είναι οι υπολογιστές σε πολλές εργασίες. Πριν μερικά χρόνια ακόμα 'ζυγίζαμε' τα πλεονεκτήματα και μειονεκτήματά τους στους διάφορους τομείς. Σήμερα πλέον, έχουμε φτάσει στο σημείο να τους θεωρούμε καθιερωμένους και προσπαθούμε να αυτοματοποιήσουμε και να προσαρμόσουμε τις εργασίες μας σε αυτούς, ώστε να έχουμε τα μέγιστα πλεονεκτήματα.

Σε αυτό το βιβλίο προσπαθούμε να παρουσιάσουμε (να κάνουμε μία εισαγωγή) τον τρόπο εργασίας σε ένα περιβάλλον σχεδιασμού στον υπολογιστή. Υπάρχουν πολλά προγράμματα, άλλα με περισσότερες και άλλα με λιγότερες λειτουργίες. Το πρόγραμμα που χρησιμοποιούμε και κατά κάποιον τρόπο παρουσιάζουμε, είναι σχετικά απλό. Διαθέτει όλες τις βασικές λειτουργίες και ακολουθεί την σύγχρονη τάση στον τρόπο λειτουργίας. Δουλεύει κάτω από περιβάλλον Windows και προσφέρει αυτοματισμούς που βοηθούν στην καθημερινή εργασία. 

Όπως όλα τα προγράμματα που διαθέτουν πολλές λειτουργίες, ο πιο σίγουρος τρόπος εκμάθησής του είναι η δοκιμή και η εξάσκηση. Αυτό το βιβλίο είναι μία απλή εισαγωγή στον τρόπο λειτουργίας ενός διανυσματικού προγράμματος σχεδιασμού.

Στην αγορά υπάρχουν πολλά διανυσματικά προγράμματα σχεδιασμού και πολλά από αυτά δουλεύουν με παρόμοιο τρόπο, τουλάχιστον στις βασικές τους λειτουργίες. Γνωρίζοντας λοιπόν ένα από αυτά, μπορούμε σχετικά εύκολα να μάθουμε και άλλα.

Η ορολογία που χρησιμοποιείται στα περισσότερα από αυτά τα προγράμματα είναι αγγλική. Για να βοηθήσουμε στην καλύτερη κατανόηση αυτής της ορολογίας χρησιμοποιούμε σε αυτό το βιβλίο όσο μπορούμε την ελληνική μετάφραση (όπου αυτή χρησιμοποιείται στην καθημερινή εργασία) μαζί με την αντίστοιχη αγγλική λέξη.

 Αυτό το βιβλίο στηρίζεται στις λειτουργίες του προγράμματος Actrix της εταιρείας Autodesk Inc. Όλες οι οθόνες και οι τεχνολογίες που χρησιμοποιούνται είναι από το συγκεκριμένο πρόγραμμα ή από το λειτουργικό Microsoft Windows και ιδιοκτησία των αντίστοιχων εταιρειών.

1 ΑΠΟ ΤΟ ΜΟΛΥΒΙ ΣΤΟΝ Η/Υ

Σε αυτό το κεφάλαιο θα. ξεχωρίσουμε τα προγράμματα σχεδιασμού ανάλογα με τον τρόπο λειτουργίας τους αλλά και με τον σκοπό τους. Υπάρχουν προγράμματα που δουλεύουν διανυσματικά και χαρτογραφικά. Ανάλογα με τους αυτοματισμούς τους, έχουμε προγράμματα μηχανολογικά, αρχιτεκτονικά, ηλεκτρομηχανολογικά κοκ.

Στη συνέχεια θα δούμε τα βασικά εργαλεία σχεδιασμού και τις βασικές έννοιες και ρυθμίσεις που αφορούν το τεχνικό σχέδιο σε έναν υπολογιστή.

1.1 Η εισαγωγή του Η/Υ στο τεχνικό σχέδιο

Οι εξελίξεις στον χώρο τον ηλεκτρονικών υπολογιστών δεν άργησαν να φτάσουν και μέχρι τον τομέα του τεχνικού σχεδίου. Με τα προγράμματα που άρχισαν να αναπτύσσονται και να εξελίσσονται στο πέρασμα του χρόνου, έρχονται αυτά τα μηχανήματα να διευκολύνουν την καθημερινή εργασία του σχεδιαστή, του μηχανικού, του αρχιτέκτονα, αλλά και όποιου άλλου έχει άμεσα σχέση με το τεχνικό σχέδιο. Και η εξέλιξη δεν σταματάει! Συνέχεια προστίθενται κι άλλοι αυτοματισμοί και ευκολίες στα σχεδιαστικά προγράμματα, έτσι ώστε πολλά από αυτά μπορούν να τα χειρίζονται ακόμα και μη ειδικοί. Υπάρχουν εκδόσεις προγραμμάτων που απευθύνονται σε απλούς χρήστες, οι οποίοι θέλουν με λίγες κινήσεις να κάνουν ένα απλό σχέδιο π.χ. του σπιτιού τους, για να δοκιμάσουν την διαρρύθμιση των επίπλων. Ειδικά για απαιτητικούς χρήστες έχουν εμπλουτιστεί προγράμματα με τόσες πολλές λειτουργίες, που απαιτείται χρόνος και συστηματική προσπάθεια για την σωστή εκμάθηση και χρήση τους.

Αρχικά τα σχεδιαστικά προγράμματα δεν είχαν πολλές ευκολίες και ο χρήστης έπρεπε να γνωρίζει τις διάφορες λειτουργίες τους πάρα πολύ καλά, απομνημονεύοντας πολλές φορές πλήθος εντολών. Σιγά σιγά άρχισαν να προσθέτονται διάφοροι αυτοματισμοί, οι οποίοι βοηθούν στην γρήγορη εκτέλεση μιας σειράς εντολών με μία μόνο κίνηση, στον υπολογισμό διάφορων στοιχείων, αλλά και στον καθορισμό των σημείων σχεδιασμού επάνω στο χαρτί. Η γενικότερη τάση να αποφεύγουμε την κίνηση του κεφαλιού από την οθόνη στο πληκτρολόγιο και πάλι πίσω (head-up design), είχε ως αποτέλεσμα να δημιουργηθούν τόσο ισχυρά εργαλεία και αυτοματισμοί, ώστε να περιοριστούν οι κινήσεις στο ελάχιστο.

Με βάση αυτά τα ισχυρά προγράμματα σχεδιασμού, έχουν αναπτυχθεί προγράμματα που εκμεταλλεύονται τις δυνατότητές τους και εκτελούν μία σειρά ελέγχων και σχεδιασμών αυτόματα. Για να σχεδιάσουμε μία πόρτα σε έναν τοίχο, έπρεπε κάποτε  να σχεδιάσουμε πρώτα τον τοίχο. Μετά έπρεπε να τον κόψουμε και να τοποθετήσουμε στο άνοιγμα την πόρτα, την οποία επίσης θα έπρεπε να σχεδιάσουμε.  Τώρα υπάρχουν προγράμματα, στα οποία απλώς ορίζουμε κάποια χαρακτηριστικά της πόρτας και αυτά την τοποθετούν στο σωστό σημείο. 

Πολλά από τα προγράμματα σχεδιασμού, έχουν την δυνατότητα και τρισδιάστατου σχεδίου. Με τα εργαλεία που προσφέρουν, βοηθούν στην κατασκευή αντικειμένων στον χώρο, ώστε να μπορούμε εύκολα να δούμε τις διάφορες όψεις τους και να ζητήσουμε διάφορους υπολογισμούς. Με λίγη δουλειά παραπάνω, καθορίζοντας τα υλικά από τα οποία αποτελείται το συγκεκριμένο αντικείμενο, μπορούμε να το αποδώσουμε ως φωτογραφία. Έχοντας αυτή την φωτογραφία στα χέρια, μπορεί ακόμα και αυτός που δεν ξέρει να διαβάσει σχέδια, να καταλάβει περί τίνος πρόκειται.

1.2 Είδη αρχείων σχεδίων / φωτογραφιών

Τα σχεδιαστικά προγράμματα χωρίζονται σε δύο κατηγορίες, ανάλογα με τον τρόπο που χειρίζονται τα στοιχειώδη αντικείμενα σχεδιασμού:

· Διανυσματικά XE "Διανυσματικά"  (vector): Σχεδιάζουμε γεωμετρικά σχήματα, τα οποία προσδιορίζονται από τα βασικά τους χαρακτηριστικά π.χ. σε ένα ευθύγραμμο τμήμα, τις συντεταγμένες αρχής και τέλους. Για αυτό το λόγο μπορούμε εύκολα τους αλλάζουμε το μέγεθος, δίχως απώλειες στην ποιότητα του σχεδίου. 

· [image: image7.wmf][image: image8.wmf]Χαρτογραφικά XE "Χαρτογραφικά"  (bitmap): Η γραμμή αποτελείται από πολλούς κόκκους. Για κάθε κόκκο πρέπει να υπάρχουν τα χαρακτηριστικά του (συντεταγμένες, χρώμα κτλ.). Σε περίπτωση μεγέθυνσης του αρχείου, δεν υπάρχουν τα απαραίτητα στοιχεία για τα ενδιάμεσα σημεία, οπότε το σχέδιο χάνει σε ευκρίνεια. Ένα ευθύγραμμο τμήμα π.χ. δημιουργείται βάζοντας πολλούς κόκκους έναν δίπλα στον άλλο. Όταν αυτή η γραμμή μεγεθυνθεί, η απόσταση αυτών των κόκκων μεγαλώνει και η γραμμή ξεχωρίζει στα επιμέρους συστατικά της.

Τα προγράμματα τεχνικού σχεδίου είναι διανυσματικά. Καταλαμβάνουν έτσι λιγότερο χώρο στον σκληρό δίσκο, αλλά και οι διαστάσεις τους και οι κλίμακες μπορούν να αλλάξουν πιο εύκολα και χωρίς απώλειες.

Τις φωτογραφίες, επειδή δεν μπορούμε εύκολα να τις αποδώσουμε με γραμμές και κύκλους, τις επεξεργαζόμαστε με χαρτογραφικά προγράμματα. Εκεί για την ευκρίνεια παίζουν πιο πολύ ρόλο η ανάλυση (πόσοι κόκκοι υπάρχουν) και το πλήθος των χρωμάτων.

1.3 Ο προσανατολισμός μας σε ένα πρόγραμμα
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Μόλις ξεκινήσουμε το πρόγραμμα, αυτό μας ζητάει να ορίσουμε το πρότυπο σχέδιο. Ανάλογα με την επιλογή μας, θα φορτωθούν ορισμένες βιβλιοθήκες και θα γίνουν βασικές ρυθμίσεις. Υπάρχει όμως και επιλογή, η οποία δεν φορτώνει τίποτα (Blank Template). Μόλις περάσουμε αυτό το πρώτο βήμα ρυθμίσεων, βλέπουμε ότι η οθόνη μας χωρίζεται σε διαφορετικές περιοχές. Η κάθε μία από αυτές έχει συγκεκριμένο ρόλο.

Στην πρώτη σειρά, στην πάνω άκρη της οθόνης μας, υπάρχει το όνομα του προγράμματος και δίπλα του το όνομα του αρχείου που δουλεύουμε αυτή την στιγμή. Αν δεν έχουμε αποθηκεύσει ακόμα το σχέδιο, δεν του έχουμε ορίσει κάποιο όνομα. Σε αυτή την περίπτωση εμφανίζεται με το όνομα 'Drawing 1'.

Στην αμέσως επόμενη σειρά, υπάρχουν τα διάφορα μενού XE "μενού" . Όλες οι εντολές που δέχεται το πρόγραμμα βρίσκονται εδώ ομαδοποιημένες.

Για να εντοπίσουμε και να ενεργοποιήσουμε κάποιο εργαλείο, θα πρέπει να ψάξουμε στα μενού. Πολλά προγράμματα τοποθετούν εικονίδια στην οθόνη, με τα οποία επιλέγουμε κατευθείαν τα συγκεκριμένα εργαλεία, γλιτώνοντας τη χρονοβόρο διαδικασία αναζήτησής τους. Αυτά τα εικονίδια είναι ομαδοποιημένα ανά είδος εργασίας σε γραμμές εργαλείων XE "γραμμές εργαλείων"  (toolbars XE "toolbars" ) και εμφανίζονται κυρίως στις επόμενες σειρές. Μπορούν όμως να τοποθετηθούν και σε διαφορετικά σημεία της οθόνης μας. Ανάλογα με το σχέδιο που κάνουμε, εμφανίζουμε τις κατάλληλες γραμμές εργαλείων, για να έχουμε στην διάθεσή μας τη μέγιστη σχεδιαστική επιφάνεια
. 

Αριστερά ή δεξιά στην οθόνη μας μπορούν να εμφανιστούν και κάποια παράθυρα, τα οποία έχουν όλα τα χαρακτηριστικά του αντικειμένου που είναι επιλεγμένο (property window XE "Property Window" ) ή μας προσφέρουν βιβλιοθήκες έτοιμων συμβόλων και σχεδίων (ActiveShapes XE "ActiveShapes" ) 

Το μεγαλύτερο μέρος της οθόνης μας το καταλαμβάνει η περιοχή σχεδίασης XE "περιοχή σχεδίασης" . Για να μπορέσουμε να αντιληφθούμε το πραγματικό μέγεθος του σχεδίου μας, εμφανίζεται η περιοχή που αντιστοιχεί στο χαρτί που θα εκτυπώσουμε λευκή. Μέσα σε αυτή την περιοχή, μπορούμε να εμφανίσουμε έναν κάνναβο.
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Στην πάνω και στην αριστερή πλευρά της περιοχής σχεδίασης υπάρχουν χάρακες XE "χάρακες"  (rulers XE "rulers" ). Οι ενδείξεις επάνω τους εξαρτώνται από το σημείο που αρχίζουν την μέτρηση (η αρχική ρύθμιση είναι η αριστερή κάτω γωνία του φύλλου εργασίας) και την κλίμακα που έχουμε ορίσει. Μπορούμε να αλλάξουμε το σημείο, από το οποίο αρχίζουν την μέτρηση (drawing plane origin XE "drawing plane origin" ), από το μενού format > coordinates. Για να εμφανίσουμε τους χάρακες και τον κάνναβο, αρκεί να τα ενεργοποιήσουμε από το μενού view.

Στην τελευταία σειρά (status bar XE "status bar" ), θα βρούμε μία σύντομη βοήθεια και τις συντεταγμένες, στις οποίες βρίσκεται ο δείκτης του ποντικιού μας, μόλις ξεκινήσουμε κάποια διαδικασία (είτε σχεδιασμού, είτε τροποποίησης).

Ο δείκτης του ποντικιού μας αλλάζει μορφή, ανάλογα με την διαδικασία στην οποία βρισκόμαστε. Όταν δεν έχουμε διαλέξει κάποιο εργαλείο, ο δείκτης είναι ένα βελάκι. Μόλις επιλέξουμε π.χ. το σχεδιασμό μίας γραμμής ή ενός άλλου αντικειμένου, μεταμορφώνεται σε ένα σταυρόνημα.

1.4 Η αρχειοθέτηση XE "αρχειοθέτηση" 
Ίσως η βασικότερη λειτουργία ενός προγράμματος είναι η δυνατότητά του να αποθηκεύει δεδομένα για μεγάλα χρονικά διαστήματα. Ένα αποθηκευμένο σχέδιο μπορεί να το ξαναφορτώσει στην μνήμη του έτσι ώστε να το εκτυπώσουμε ή ακόμα και να το επεξεργαστούμε.

Οι βασικές λειτουργίες της αρχειοθέτησης είναι τρεις:

· το άνοιγμα XE "άνοιγμα"  ή φόρτωμα (open XE "open" 

 XE "open" )

· η αποθήκευση XE "αποθήκευση"  (save XE "save" ) και
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η αποθήκευση με άλλο όνομα XE "αποθήκευση: με άλλο όνομα"  (save XE "save:save as..."  as…)

Εκτός από αυτές της λειτουργίες, υπάρχουν και εντολές

· για την δημιουργία νέου σχεδίου XE "δημιουργία νέου σχεδίου"  (new XE "new" )

· για το κλείσιμο ενός σχεδίου XE "κλείσιμο ενός σχεδίου"  (close XE "close" )

Όπως και με άλλες εντολές, μπορούμε να τις ενεργοποιήσουμε είτε από την γραμμή εργαλείων είτε από τα μενού.

Στο ίδιο μενού εμφανίζεται μία λίστα των τελευταίων επεξεργασμένων αρχείων. Επιλέγοντας ένα από αυτά, φορτώνεται αμέσως στην μνήμη, χωρίς να χρειαστεί να το αναζητήσουμε στο σκληρό δίσκο.
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Προσοχή! Το πρόγραμμα επιτρέπει την ταυτόχρονη επεξεργασία πολλών σχεδίων. Αυτό σημαίνει, ότι αν ξεκινήσουμε την δημιουργία ενός νέου σχεδίου χωρίς να κλείσουμε ένα ήδη ανοιχτό, θα έχουμε δύο σχέδια ανοιχτά! Μπορούμε να μετακινούμαστε από το ένα στο άλλο μέσω του μενού Window. Στην διπλανή εικόνα βλέπουμε ότι υπάρχουν τρία ανοιχτά σχέδια και ενεργό είναι το τρίτο.

1.5 Οι βασικές XE "ρυθμίσεις:βασικές"  ρυθμίσεις

Για να μπορούμε να παρακολουθούμε την πορεία του σχεδίου, το πρόγραμμα μάς εμφανίζει μία περιοχή της οθόνης λευκή. Αυτή αντιστοιχεί στο χαρτί που θα εκτυπώσουμε και η εμφάνισή της αλλάζει ανάλογα με το μέγεθος του χαρτιού XE "μέγεθος του χαρτιού" 
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Η ρύθμιση της κλίμακας XE "ρυθμίσεις:κλίμακας"  γίνεται από το μενού Format > Scale. Στο παράθυρο που ανοίγει ορίζουμε την κλίμακα του σχεδίου μας.

[image: image14.png]Orentaon
e  Pouait

T - € Landscape

et [om =]

~Margns

Lett = T Jom =

B orm = oo [orm =

scake

© 5ol [0 =z

cae = sessacossty 1 = b




Το μέγεθος του χαρτιού XE "ρυθμίσεις: μέγεθος χαρτιού"  στο οποίο θα εκτυπώσουμε, το ορίζουμε από το μενού File > Page Setup. Εκεί υπάρχουν και ρυθμίσεις που αφορούν τα περιθώρια και τον προσανατολισμό του χαρτιού.
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Μέσα στην επιφάνεια που αντιστοιχεί στο χαρτί μας, εμφανίζεται ένας κάνναβος XE "κάνναβος"  (grid XE "ρυθμίσεις: grid" ). Ο κάνναβος αυτός είναι χρήσιμος για να αντιλαμβανόμαστε τα μεγέθη των αντικειμένων που σχεδιάζουμε, αλλά και για να πετύχουμε ακρίβεια στον σχεδιασμό. Για να τον ενεργοποιήσουμε, θα βρούμε στο μενού Format > Grid επιλογές που αφορούν την εμφάνιση και το μέγεθός του. Θα βοηθηθούμε πολύ στο σχέδιο, αν τον ρυθμίσουμε σε ένα βασικό μέγεθος του σχεδίου. 
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Η μονάδα μέτρησης XE "ρυθμίσεις:μονάδα μέτρησης"  του σχεδίου μας καθορίζεται στο μενού Format > Units. Εκεί υπάρχουν ξεχωριστές ρυθμίσεις για την μονάδα μέτρησης των αντικειμένων που θα σχεδιάσουμε και για τα κείμενα και τα πάχη των γραμμών. Η ρύθμιση αυτής της μονάδας μέτρησης αφορά τα διάφορα εργαλεία του προγράμματος. Τα ενεργά σχήματα, που θα δούμε στα επόμενα κεφάλαια, έχουν πάντα την δική τους μονάδα μέτρησης, αυτή με την οποία δημιουργήθηκαν.

Θα πρόσεξες, πως ανοίγοντας μία από τις τελευταίες ρυθμίσεις, ανοίγει το ίδιο παράθυρο, απλά σε άλλη καρτέλα ('Units', 'Scale', 'Grid' κ.λπ.). Για να μεταβούμε σε μία άλλη ρύθμιση, αρκεί να επιλέξουμε άλλη καρτέλα.

Άσκηση: Να ρυθμιστούν σε ένα καινούριο σχέδιο (ξεκινώντας με το πρότυπο 'Blank Template'!):

· Μονάδα μέτρησης για το σχέδιο:
μέτρα

· Μονάδα μέτρησης για τα κείμενα:
mm (χιλιοστόμετρα)

· Κλίμακα:
1:100

· Grid:
ανά 10 cm
· Μέγεθος σελίδας:
Α4

1.6 Εμφάνιση του σχεδίου: Ζουμ XE "Ζουμ" 
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Την οθόνη μας θα πρέπει να την φανταστούμε σαν μία φωτογραφική μηχανή, η οποία εστιάζει στο σχέδιό μας και μας το δείχνει από πιο κοντά ή πιο μακριά. Ανάλογα με το ζουμ που κάνουμε, τα σχεδιασμένα αντικείμενα φαίνονται πιο μικρά όταν τα παρατηρούμε από μακριά και πιο μεγάλα όταν πάμε πιο κοντά. Σε καμία από αυτές τις περιπτώσεις το μέγεθος των αντικειμένων στο σχέδιο δεν αλλάζει!

Στο αριστερό παράδειγμα βλέπουμε την εμφάνιση του σχεδίου με ρύθμιση ζουμ στα 100%, ενώ στο δεξί η ρύθμιση είναι 400%.
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Ειδικά για τον καθορισμό της περιοχής του σχεδίου που θα μεγεθυνθεί υπάρχουν διάφορα εργαλεία:

	Pan XE "Pan" 
	Μετακινούμε το σχέδιό μας (όλο το φύλλο εργασίας)

	Zoom XE "Zoom"  
	In/Out: Κρατάμε το αριστερό πλήκτρο του ποντικιού πατημένο και το μετακινούμε πάνω / κάτω. Όταν το μετακινούμε προς τα πάνω, το σχέδιο έρχεται πιο κοντά, ενώ όταν το μετακινούμε προς τα κάτω, αυτό φεύγει πιο μακριά.

	Zoom Window
	Καθορίζουμε μία περιοχή του σχεδίου μας, την οποία θέλουμε να δούμε σε μεγέθυνση.

	Zoom Control
	Από αυτή την λίστα επιλέγουμε το ποσοστό της μεγέθυνσης που θέλουμε να κάνουμε ή την προσαρμογή της οθόνης μας σε συγκεκριμένη περιοχή του σχεδίου.


Άσκηση: Άνοιξε ένα σχέδιο από τα παραδείγματα. Δοκίμασε να μεγεθύνεις διάφορες περιοχές για να δεις λεπτομέρειες. Χρησιμοποίησε όλα τα παραπάνω εργαλεία.

ΠΑΡΑΔΕΙΓΜΑ

Στο παρακάτω παράδειγμα θα ανοίξουμε το σχέδιο 'P&ID - Horizontal Separator' που βρίσκεται στον φάκελο των παραδειγμάτων ('Samples') του προγράμματός μας.
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Βήμα 1ο: Πρέπει να ανοίξουμε το σχέδιο.

Αυτό γίνεται με την εντολή File > Open
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Στο επόμενο παράθυρο που ανοίγει, επιλέγουμε τον φάκελο των δειγμάτων ('Samples') με διπλό πάτημα του αριστερού πλήκτρου του ποντικιού (ή απλό πάτημα και επιβεβαίωση με Open).
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Μόλις ανοίξει ο φάκελος με τα αρχεία, επιλέγουμε (πάλι με διπλό πάτημα) αυτό που μας ενδιαφέρει.

Αφού φορτωθούν όλα τα δεδομένα από τον σκληρό δίσκο στη μνήμη του υπολογιστή μας, εμφανίζεται το σχέδιο στην οθόνη μας.

Βήμα 2ο: Εμφάνιση λεπτομερειών του σχεδίου.

Για να δούμε κάποιες λεπτομέρειες του σχεδίου, θα πρέπει να χρησιμοποιήσουμε το κατάλληλο εργαλείο. Είδαμε ότι το πρόγραμμα διαθέτει διάφορα εργαλεία που έχουν σχέση με την μεγέθυνση. Πρόκειται για τα εργαλεία 'Ζουμ'.
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Θα χρειαστούμε το εργαλείο Zoom Window για να καθορίσουμε την μεγέθυνση μιας συγκεκριμένης περιοχής.
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Ο δείκτης του ποντικιού μας αλλάζει σε σταυρό. Με αυτόν ορίζουμε την κεντρική περιοχή του σχεδίου: κρατάμε το αριστερό πλήκτρο του ποντικιού πατημένο και τραβάμε το ποντίκι διαγώνια, ώστε να δημιουργηθεί ένα πλαίσιο. 

Μόλις αφήσουμε το πλήκτρο του ποντικιού, αλλάζει το σχέδιο στην οθόνη.
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Αν θέλουμε να ελέγξουμε μέρη του σχεδίου που δεν εμφανίζονται, μπορούμε να το μετακινήσουμε. Το εργαλείο Pan μετατρέπει το δείκτη του ποντικιού μας σε 'χέρι'. Κρατώντας το πατημένο επάνω στο σχέδιο, μπορούμε να το μετακινήσουμε όπως θέλουμε.
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Παρακάτω βλέπουμε μία τέτοια μετακίνησ[image: image27.png]et
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Για να κάνουμε μικρές αλλαγές στη μεγέθυνση, μπορούμε να επιλέξουμε και το μεγεθυντικό φακό. Αμέσως αλλάζει πάλι ο δείκτης του ποντικιού μας και παίρνει την μορφή του εργαλείου (μεγεθυντικός φακός). Κρατώντας τον πατημένο επάνω στο σχέδιο, μπορούμε να βλέπουμε το σχέδιο από πιο κοντά μετακινώντας το προς τα επάνω. Η μετακίνηση προς τα κάτω μικραίνει το σχέδιο, σαν να το πηγαίνει πιο μακριά.

Στο πεδίο που εμφανίζεται λίγο πιο δεξιά, υπάρχουν κάποια προεπιλεγμένα (βασικά) ποσοστά μεγέθυνσης που μπορούμε να δούμε.
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Οι τρεις τελευταίες εντολές μάς επιτρέπουν να επαναφέρουμε έτσι το σχέδιο, ώστε να εμφανιστούν όλα τα αντικείμενα που σχεδιάσαμε. 

· Η επιλογή Page Width μεγεθύνει και εμφανίζει το πλάτος της σελίδας στο μέγιστο. 

· To Whole Page εμφανίζει όλα τα σχεδιασμένα αντικείμενα στην οθόνη μας.

· Με την επιλογή Fit All προσαρμόζουμε όλο το σχέδιο, οτιδήποτε έχει σχεδιαστεί, μέσα στην οθόνη μας.

Αν υπάρχουν επιλεγμένα αντικείμενα, εμφανίζεται και μια τέταρτη επιλογή: 'Fit Selected'. Με αυτή μεγεθύνουμε στο μέγιστο τα επιλεγμένα αντικείμενα.

Στην ίδια λίστα επιλογών μπορούμε να ορίσουμε ένα ποσοστό μεγέθυνσης από τα προτεινόμενα ή πληκτρολογώντας το.

Για να επαναφέρουμε το σχέδιο στην αρχική του κατάσταση, εμφανίζοντάς το ολόκληρο, ποια επιλογή είναι η σωστή;
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Μπορούμε να διαλέξουμε είτε την 'Whole page' είτε την 'Fit All'.

2 Σχεδιάζουμε διαγράμματα

Πολλές φορές πρέπει να αναλύσουμε την ροή κάποιων εργασιών ή την δομή μίας οργάνωσης. Πολύ χρήσιμο είναι σε αυτές τις περιπτώσεις να τα σχεδιάσουμε με κάποιον τρόπο σε χαρτί. Αυτό γίνεται με την μορφή ενός διαγράμματος. 

Σε αυτό το κεφάλαιο θα μάθουμε να σχεδιάζουμε διαγράμματα XE "διαγράμματα"  με την βοήθεια ενός προγράμματος.
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2.1 Βιβλιοθήκες έτοιμων συμβόλων

Πολλά από τα σχήματα ενός σχεδίου επαναλαμβάνονται είτε στο ίδιο είτε σε άλλα. Για να μην τα σχεδιάζουμε από την αρχή κάθε φορά, μπορούμε να τα αποθηκεύουμε, έτσι ώστε να τα έχουμε έτοιμα όποτε τα χρειαζόμαστε. Χρήσιμη είναι η λειτουργία αποθήκευσης και ορισμένων επιπλέον χαρακτηριστικών τέτοιων σχεδίων, όπως π.χ. ο κωδικός κατασκευαστή του συγκεκριμένου αντικειμένου, η τιμή κ.ά.
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Τα έτοιμα σύμβολα του προγράμματός μας είναι ενεργά σχήματα XE "ενεργά σχήματα"  (ActiveShapes XE "ActiveShapes" ). Κάποια τοποθετούνται αυτόματα, άλλα εμφανίζουν διάφορα στοιχεία τους ανάλογα με τις ρυθμίσεις μας.

Τα ενεργά σχήματα είναι αποθηκευμένα σε καταλόγους. Ανάλογα με το σχέδιό μας μπορούμε να φορτώσουμε τέτοιους καταλόγους ή να δημιουργήσουμε καινούργιους. Με τις επιλογές που έχουμε από το παράθυρο των ενεργών σχημάτων, μπορούμε
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	New Catalog XE "Catalog" 
	να δημιουργήσουμε έναν καινούργιο κατάλογο
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	Open Catalog
	να φορτώσουμε από το δίσκο έναν κατάλογο στο σχέδιό μας
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	Save Catalog as
	να αποθηκεύσουμε έναν κατάλογο από το σχέδιό μας στο σκληρό δίσκο και
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	Close Catalog
	να κλείσουμε έναν ανοικτό κατάλογο του σχεδίου μας


Υπάρχει ένα ειδικό παράθυρο για τα ενεργά σχήματα. Σε αυτό εμφανίζονται τα ενεργά σχήματα του ανοιχτού καταλόγου και όλοι οι φορτωμένοι κατάλογοι. Επίσης υπάρχουν ειδικά εικονίδια για τις λειτουργίες των καταλόγων. Αν δεν υπάρχει στην οθόνη μας το παράθυρο των ενεργών σχημάτων, απλά πατάμε το πλήκτρο F8.

2.2 Διάγραμμα ροής XE "Διάγραμμα ροής" 
Για να εισάγουμε ένα ενεργό σχήμα στο σχέδιό μας, ακολουθούμε την παρακάτω διαδικασία:

Βήμα 1ο: Φορτώνουμε τον κατάλογό του στο σχέδιο 
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Επιλέγουμε το εικονίδιο που ανοίγει τους καταλόγους (Open Catalog). Ανοίγει το παράθυρο που βλέπουμε δίπλα. Τώρα πρέπει να επιλέξουμε το φάκελο που περιλαμβάνει το ενεργό σχήμα που μας ενδιαφέρει.
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Τα ενεργά σχήματα είναι ομαδοποιημένα σε βιβλιοθήκες XE "βιβλιοθήκες" , ανάλογα με τoν τομέα στον οποίο απευθύνονται. Επιλέγουμε το φάκελο 'Business'. Σε αυτή τη βιβλιοθήκη θα βρούμε τους καταλόγους που αφορούν διαγράμματα (οργανογράμματα και διαγράμματα ροής). Αφού επιλέξουμε τα βασικά σχήματα για διαγράμματα ροής ('Basic Flowchart'), κλείνει αυτό το παράθυρο και στο σχέδιό μας φορτώνονται τα ενεργά σχήματα που περιλαμβάνονται σε αυτό τον κατάλογο.
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Βήμα 2ο: Εισάγουμε και αντιγράφουμε τα ενεργά σχήματα

Αφού έχουμε φορτώσει τον κατάλογο με τα ενεργά σχήματα στο σχέδιο, μπορούμε να τα χρησιμοποιήσουμε. 
Για να εισάγουμε ένα ενεργό σχήμα στο σχέδιο, απλά το επιλέγουμε και το σέρνουμε από την περιοχή του καταλόγου στο σχέδιό μας.

Αφού το έχουμε πλέον εισάγει, μπορούμε εύκολα να το αντιγράφουμε μέσα στο σχέδιο. Η αντιγραφή ενός αντικειμένου του σχεδίου είναι απλή κίνηση:

1. Το επιλέγουμε (πατάμε μία φορά με το αριστερό πλήκτρο του ποντικιού επάνω του)

2. Κρατάμε το πλήκτρο 'Control' (ή 'Ctrl', ανάλογα με το πληκτρολόγιο)  πατημένο και μετακινούμε το αντικείμενο στην καινούρια του θέση. Αυτό που μετακινείται είναι ένα αντίγραφο και όχι το πρωτότυπο.
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Κατά την μετακίνηση μπορούμε να κρατήσουμε και το πλήκτρο 'Shift' πατημένο (ταυτόχρονο με το 'Control'). Σε αυτή την περίπτωση το αντικείμενο μετακινείται μόνο οριζόντια και κάθετα και μάλιστα στους άξονες που περνούν από την αρχική του θέση.

Ορισμένα από τα ενεργά σχήματα, αλλάζουν μορφή ή έχουν αυτοματισμούς για την τοποθέτησή τους στο σχέδιο. Αυτές τις επιλογές, όπως και τα υπόλοιπα χαρακτηριστικά ενός ενεργού σχήματος, μπορούμε να τα ελέγξουμε πατώντας το δεξί πλήκτρο στο ποντίκι.

Στα ενεργά σχήματα υπάρχουν δύο βοηθήματα για την τοποθέτηση των σχημάτων αλλά και την διασύνδεση μεταξύ τους. Πρόκειται για

· τους οδηγούς (Plugs) XE "Plugs" , οι οποίοι συνδέονται σε οδηγούς XE "οδηγούς"  και υποδοχές XE "υποδοχές" , και 

· τις υποδοχές (Sockets) XE "Sockets" , οι οποίες δέχονται μόνο plugs
Υπάρχουν ειδικά ενεργά σχήματα για να συνδέσουμε τα αντικείμενα του διαγράμματος. Αυτά βρίσκονται στην βιβλιοθήκη 'Shared Catalogs', στον κατάλογο 'Connectors'.
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Και αυτά τα ενεργά σχήματα τα εισάγουμε και τα χρησιμοποιούμε όπως ακριβώς όλα τα άλλα. Όταν επιλέξουμε ένα τέτοιο, θα δούμε ότι έχει κάποιες ειδικές λαβές XE "λαβές"  (με κίτρινο χρώμα). Με αυτές μπορούμε να τροποποιήσουμε τα σχήματα και να τα προσαρμόσουμε στο διάγραμμά μας. Για να τα τοποθετήσουμε ακριβώς στο διάγραμμα, εισάγοντάς τα τοποθετούμε τη μία λαβή στο σωστό σημείο. Μετά, μετακινούμε και την άλλη.
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Είδαμε νωρίτερα, ότι κατά την εκκίνηση του προγράμματός μας, αλλά και όταν θελήσουμε να δημιουργήσουμε ένα καινούριο σχέδιο, μπορούμε να στηριχτούμε σε ένα πρότυπο XE "πρότυπο" . Και αυτά είναι ομαδοποιημένα. Για τα διαγράμματα θα βρούμε τα πρότυπα στην καρτέλα 'Business'. Αν επιλέξουμε το πρότυπο για τα βασικά διαγράμματα ('Basic Flowchart'), φορτώνεται ο αντίστοιχος κατάλογος και αυτός των συνδέσεων ('Connectors'). 

Άσκηση: Φόρτωσε τον κατάλογο διαγραμμάτων 'Basic Flowchart' από το φάκελο 'business'. Εκεί θα βρεις το ενεργό σχήμα 'Multishape'. Αυτό έχει την δυνατότητα να αλλάζει μορφή. 
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Με πατημένο το αριστερό πλήκτρο του ποντικιού επάνω του, το σέρνεις και το εισάγεις στο σχέδιο.
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Μετά το επιλέγεις με το δεξί πλήκτρο του ποντικιού. Αμέσως ανοίγει ένα παράθυρο, στο οποίο μπορείς  να ορίσεις την μορφή του (process, decision, data, document).

Ανάλογα με την επιλογή σου, το ενεργό σχήμα αλλάζει μορφή.

Τοποθέτησε δύο αντικείμενα σύμφωνα με το διπλανό σχήμα.
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Για να μπορέσεις να προχωρήσεις στην παρακάτω άσκηση, χρειάζεται μία ρύθμιση στις έλξεις. Οι έλξεις (θα τις δούμε αναλυτικά σε άλλο κεφάλαιο) μας βοηθούν να ορίζουμε εύκολα κάποια σημεία σε αντικείμενα. Την απαραίτητη ρύθμιση θα την βρεις στο παράθυρο AutoSnap (Tools > AutoSnap).

Ρύθμισε τις έλξεις σύμφωνα με την παραπάνω εικόνα. Ενεργές θα πρέπει να είναι οι έλξεις Sockets και Grid, δηλ. οι έλξεις στις υποδοχές των αντικειμένων και στον κάνναβο (για να ευθυγραμμίζονται πιο εύκολα τα αντικείμενα).

Θυμήσου: Με τα πλήκτρα 'shift' και 'ctrl' μπορούμε να αντιγράφουμε και να περιορίζουμε την μετακίνηση.

Για να συνδέσουμε τα δύο αντικείμενα που σχεδιάσαμε, θα πρέπει να εισάγουμε ένα κατάλληλο ενεργό σχήμα, έστω το 'Straight Connector' (συνδέει ευθύγραμμα), το οποίο υπάρχει και στους δύο, ήδη φορτωμένους, καταλόγους μας. 
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Εισάγοντάς το, είναι ενεργές οι έλξεις (τις ενεργοποιήσαμε στην προηγούμενη κίνησή μας). Μόλις το πλησιάσουμε στο αντικείμενο που θέλουμε να συνδέσουμε, εμφανίζεται το εικονίδιο της έλξης (βλ. εικόνα). Εκεί μπορούμε να το αφήσουμε. 
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Αφού το αφήσουμε, παραμένει ενεργό και βλέπουμε τις δύο λαβές στα άκρα του.

Θα πρέπει να μετακινήσουμε και το άλλο άκρο του στο σωστό σημείο. 
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Πιάνουμε την άλλη λαβή και τοποθετούμε την άλλη άκρη αυτής της γραμμής στο δεύτερο αντικείμενο.
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Μπορούμε να προσθέσουμε πολύ εύκολα κείμενο επάνω σε αυτή τη γραμμή. Αρκεί να πατήσουμε δύο φορές γρήγορα το αριστερό πλήκτρο του ποντικιού επάνω της ή να επιλέξουμε Εdit Text από τις επιλογές που ανοίγουν πατώντας το δεξί πλήκτρο του ποντικιού επάνω στην γραμμή. Στο πλαίσιο που ανοίγει μπορούμε να πληκτρολογήσουμε το κείμενό μας.

[image: image47.png]


Μέσα από το παράθυρο ιδιοτήτων (ανοίγει πατώντας το πλήκτρο F9) μπορούμε να ελέγξουμε και να αλλάξουμε τις ιδιότητες του επιλεγμένου αντικειμένου. Επιλέγουμε την γραμμή που βάλαμε τελευταία και στο παράθυρο ιδιοτήτων αλλάζουμε στην καρτέλα με εικονίδιο ένα πινέλο. Εκεί, μπορούμε να ζητήσουμε να εμφανίζεται ένα βέλος στο τέλος της γραμμής ('End Arrow') και μάλιστα να έχει μεγαλύτερο μέγεθος ('Arrow Size').
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Το αποτέλεσμα των παραπάνω κινήσεων το βλέπουμε στη διπλανή εικόνα.
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Άσκηση

Σχεδίασε το παρακάτω (αντιγράφεις το ενεργό σχήμα, του αλλάζεις μορφή και τα συνδέεις μεταξύ τους)

Πρόσεξε ότι τα συνδέεις στα σημεία όπου υπάρχουν υποδοχές (θα πρέπει να έχεις ενεργοποιημένη την έλξη στις υποδοχές).

Ένα ακόμα διάγραμμα ροής:

[image: image5.wmf]ÁÐÁÉÔÅÉÔÁÉ 

ÐÑÏÅÃÊÑÉÓÇ 

×ÙÑÏÈÅÔÇÓÇÓ

ÅÊÐÏÍÇÓÇ ÌÐ×

ÁÐÁÉÔÅÉÔÁÉ 

ÂÅÂÁÉÙÓÇ 

ÁÐÁËËÁÃÇÓ

ÕÐÏÂÏËÇ ÁÉÔÇÓÇÓ 

ÁÐÁËËÁÃÇÓ

----------------

ÅÑÃÁ ÌÉÊÑÇÓ ÅÊÔÁÓÇÓ 

ÊÁÉ ÅÍÔÁÓÇÓ

ÊÁÔÁÈÅÓÇ ÌÐ× ÓÔÏ 

ÖÏÑÅÁ ÕËÏÐÏÉÇÓÇÓ

ÁÐÏÓÔÏËÇ ÃÉÁ 

ÃÍÙÌÏÄÏÔÇÓÇ

ÂÅÂÁÉÙÓÅÉÓ ÓÅ ÁËËÏÕÓ 

ÖÏÑÅÉÓ

* ÕÐÐÏ

*ÕÐ. ÃÅÙÑÃÉÁÓ

*ÍÅ×ÙÐ

----------------------------

ÃÍÙÌÏÄÏÔÇÓÇ ÖÏÑÅÙÍ

ÅËÅÃ×ÏÓ ÊÁÉ ÕÐÏÂÏËÇ 

ÖÁÊÅËÏÕ Ð× ÓÔÏ 

ÕÐÅ×ÙÄÅ 

(ÐÅÑÉÖ. ÊÅÍÔÑ.)

* ÅÎÁÉÑÅÓÇ ÁÐ ÊÁÔ. 

ÊÕÁ 69269

* ÕÐÅ×ÙÄÅ 90516/90517

* Â ÊÁÔ. ÊÕÁ 69269

* Äåí áðáéôåßôáé ÌÐ× / 

ÌÐÅ

ÃÍÙÌÏÄÏÔÇÓÇ 

ÕÐÅ×ÙÄÅ

(ÐÅÑÉÖ. ÊÅÍÔÑ.)

ÓÕÌÖÙÍÇ ÃÍÙÌÇ 

ÕÐÅ×ÙÄÅ

ÅÃÊÑÉÓÇ Ð.×.

ÁÐÁÉÔÅÉÔÁÉ ÅÊÐÏÍÇÓÇ 

ÌÐÅ

ÕÐÏÂÏËÇ ÌÐÅ ÓÔÏ 

ÖÏÑÅÁ ÕËÏÐÏÉÇÓÇÓ

ÅËÅÃ×ÏÓ ÌÐÅ ÁÐÏ 

ÖÏÑÅÁ ÕË¼ÐÏÉÇÓÇÓ

ÕÐÏÂÏËÇ ÌÐÅ ÓÔÏ 

ÕÐÅ×ÙÄÅ ÁÐÏ ÖÏÑÅÁ 

ÕËÏÐÏÉÇÓÇÓ

ÅËÅÃ×ÏÓ ÊÁÉ 

ÁÐÏÓÔÏËÇ ÌÐÅ ÁÐÏ 

ÕÐÅ×ÙÄÅ

ÃÍÙÌÏÄÏÔÇÓÇ 

ÓÕÍÁÑÌÏÄÉÙÍ 

ÕÐÏÕÑÃÅÉÙÍ

ÃÍÙÌÏÄÏÔÇÓÇ 

ÍÏÌÁÑ×ÉÁÊÏÕ 

ÓÕÌÂÏÕËÏÕ

ÅÃÊÑÉÓÇ 

ÐÅÑÉÂÁËËÏÍÔÉÊÙÍ 

ÏÑÙÍ ÁÐÏ ÕÐÅ×ÙÄÅ

ÉÓ×ÕÅÉ Ç Ì.Ð.×. ÙÓ ÌÐÅ 

(åö' üóïí õðÜñ÷åé)

ÍÁÉ

Ï×É

ÉÓÙÓ

ÍÁÉ

Ï×É

ÍÁÉ

Ï×É

Ï×É

ÍÁÉ

ÄÉÁÄÉÊÁÓÉÁ ÐÅÑÉÂÁËËÏÍÔÉÊÇÓ ÁÄÅÉÏÄÏÔÇÓÇÓ


2.3 Οργανόγραμμα

Ποιες είναι οι ειδικότητες του τομέα Κατασκευών στα ΤΕΕ; 

Θα δημιουργήσουμε ένα απλό οργανόγραμμα XE "οργανόγραμμα"  με αυτές τις ειδικότητες. Ξέρουμε ότι είναι οι παρακάτω πέντε ειδικότητες:

1. Κτιριακών έργων

2. Επεξεργασίας απορριμμάτων και αποβλήτων

3. Τοπογραφικών εργασιών

4. Βαφέων οικοδομών

5. Σχεδιαστών τεχνικών έργων - Χρήση Η/Υ

 Πώς θα το εμφανίσουμε με ένα απλό διάγραμμα;
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Στην βιβλιοθήκη 'Business' υπάρχει ένας κατάλογος με τα ενεργά σχήματα που χρειαζόμαστε. Πρόκειται για τον κατάλογο 'Organization Chart Groups'. Εκεί θα βρούμε το ενεργό σχήμα 'Top - 5 reports'. Ορίστε το αποτέλεσμα:
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Τώρα πρέπει να αλλάξουμε το κείμενο μέσα στα κελιά. Αυτό γίνεται πολύ απλά: με διπλό πάτημα του αριστερού πλήκτρου του ποντικιού επάνω σε ένα κελί. Αυτό ανοίγει ένα πλαίσιο κειμένου μέσα στο κελί, όπου μπορούμε να πληκτρολογήσουμε το κείμενό μας.
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Αν θέλουμε να γράψουμε κείμενο με διαφορετική γραμματοσειρά από την προεπιλεγμένη, αρκεί να αλλάξουμε την ρύθμιση από την γραμμή εργαλείων των κειμένων πριν το πληκτρολογήσουμε. 

Μπορούμε όμως και από τις ιδιότητες του κελιού να αλλάξουμε το είδος και το μέγεθος των γραμμάτων.
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Επιλέγουμε το κελί που θέλουμε να τροποποιήσουμε (η γραμμή του πλαισίου του αλλάζει από συνεχόμενη σε διακεκομμένη) και διαλέγουμε τη γραμματοσειρά και το μέγεθος των γραμμάτων από το παράθυρο των ιδιοτήτων του. Εκεί μπορούμε να επιλέξουμε, αν θέλουμε, και έντονα ή πλάγια γράμματα.
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Μεταφέραμε τις πληροφορίες μας στο χαρτί, αλλά η εμφάνισή τους δεν είναι και πολύ σπουδαία. Μπορούμε να βάλουμε και λίγο χρώμα στο σχέδιό μας (και στη ζωή μας). Αρκεί να επιλέξουμε το κελί που θέλουμε να βάψουμε και από την γραμμή εργαλείων ρυθμίσεων (Format) το χρώμα που θέλουμε να το γεμίσουμε. Τα ίδια αποτελέσματα έχουμε και από την αντίστοιχη καρτέλα στο παράθυρο ιδιοτήτων.
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Το τελικό μας αποτέλεσμα μπορεί να είναι κάπως έτσι:

Άσκηση

Μπορείς να σχεδιάσεις το παρακάτω οργανόγραμμα;
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Μπορείς να ξεκινήσεις με το πρότυπο 'Organization Chart' από την καρτέλα 'Business'. Αυτό θα φορτώσει όλους τους απαραίτητους καταλόγους.

Μπορείς να σχεδιάσεις και μία παραλλαγή του παραπάνω διαγράμματος, αρκεί να είναι ξεκάθαρες όλες οι δυνατότητες που έχουν οι μαθητές των ΤΕΕ.

3 Μία απλή κάτοψη

Με τους αυτοματισμούς που έχει ενσωματωμένους αυτό το πρόγραμμα και κυρίως με τα ενεργά σχήματα, μπορούμε να σχεδιάσουμε πολύ γρήγορα και κατόψεις κτιρίων. Στην συνέχεια θα δούμε ένα τέτοιο παράδειγμα.

Σ' αυτό το κεφάλαιο θα σχεδιάσουμε μία κάτοψη (ένα μικρό γραφείο) σαν την παρακάτω:
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3.1 Οι εξωτερικοί τοίχοι

Μπορούμε να ξεκινήσουμε το σχέδιό μας βασιζόμενοι στο πρότυπο 'Sxedio100'. Αν δεν το έχουμε στη διάθεσή μας, αρκεί να κάνουμε τις αρχικές ρυθμίσεις μόνοι μας.

Θα χρειαστούμε από την βιβλιοθήκη 'Shared Catalogs' τους παρακάτω καταλόγους:

· 'Walls, Doors and Windows' 

· 'Architecture' 

Επιβεβαίωσε τις παρακάτω ρυθμίσεις:

Μονάδα μέτρησης: μέτρο ('Units')

Κλίμακα: 1:50 ('Scale')

Κάνναβος: ανά 10 cm ('Grid')

Μέγεθος χαρτιού: Α4  ('Page Setup')

Έλξεις: Sockets
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Τους εξωτερικούς τοίχους τους δημιουργούμε εισάγοντας τα αντίστοιχα ενεργά σχήματα.

Αν χρειαστεί να αποθηκεύσεις ενδιάμεσα το σχέδιο στον σκληρό δίσκο, μπορείς να ακολουθήσεις την διαδικασία που περιγράφεται στο τέλος αυτού του κεφαλαίου.
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Εισάγουμε αρχικά έναν οριζόντιο τοίχο και του αλλάζουμε τα χαρακτηριστικά από το παράθυρο των ιδιοτήτων (αν δεν εμφανίζεται μπορούμε με F9 να το ενεργοποιήσουμε):

Αυτά τα ενεργά σχήματα έχουν σχεδιαστεί σε χιλιοστά του μέτρου, γι' αυτό προσέχουμε να ορίζουμε τις τιμές αυτές σε χιλιοστά.
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μήκος ('Length'): 8000 mm
πλάτος ('Width'): 300 mm (αυτή η αλλαγή γίνεται μόνο από τη δεύτερη καρτέλα των ιδιοτήτων, 'Extented Properties')

Το κάθετο κομμάτι, που εισάγουμε στη συνέχεια, θα έχει το ίδιο πλάτος αλλά 

μήκος: 5000 mm
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Επειδή όλα τα μήκη μετρώνται αξονικά και οι συνδέσεις γίνονται στη μέση του τοίχου, τελικά, ενώνοντας τους κάθετους τοίχους, ο αυτοματισμός τους επιμηκύνει τόσο, όσο χρειάζεται για να κλείσουν τα κενά. Στις παρακάτω εικόνες βλέπουμε τα σημεία που είναι ενεργά και έλκονται και πώς τελικά συνδέονται.

Οι οριζόντιοι τοίχοι (μετά την ολοκλήρωση όλων των εξωτερικών τοίχων) θα έχουν μήκος 8,30 m και οι κάθετοι 5,30 m.

Έχοντας έναν οριζόντιο και έναν κάθετο τοίχο (επάνω και δεξιά) μπορούμε να τους αντιγράψουμε και να τους τοποθετήσουμε στη σωστή τους θέση. Με πατημένο το πλήκτρο 'Control' μετακινούμε ένα αντίγραφο του δεξιού τοίχου αριστερά. Προσέχουμε να το μετακινούμε πιάνοντάς το κοντά στο άκρο του που θέλουμε να 'κολλήσει' (για να είναι ενεργή η έλξη αυτού του σημείου).

 Αφού το τοποθετήσουμε, συνεχίζουμε και με το δεύτερο οριζόντιο τοίχο. Εδώ μπορούμε να δοκιμάσουμε μία άλλη κίνηση. 
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Μεταφέρουμε ένα αντίγραφο του επάνω τοίχου κάτω και το αφήνουμε όπως στην διπλανή εικόνα.
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Μετά πιάνουμε τη μία άκρη του και την μετακινούμε μέχρι να ενεργοποιηθεί η έλξη, οπότε και την αφήνουμε (βλ. διπλανή εικόνα). Το ίδιο κάνουμε και με την άλλη άκρη. Το αποτέλεσμα το βλέπουμε στην παρακάτω εικόνα.
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Ολοκληρώσαμε το σχεδιασμό των εξωτερικών τοίχων. 
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Οι εσωτερικοί τοίχοι

Ήρθε η σειρά των εσωτερικών τοίχων. Στον ίδιο κατάλογο που χρησιμοποιούσαμε μέχρι τώρα, υπάρχουν ορισμένα ενεργά σχήματα που μπορούμε να χρησιμοποιήσουμε. Από τον συμβολισμό τους, τον οποίο βλέπουμε, καταλαβαίνουμε σε ποιες περιπτώσεις τα χρησιμοποιούμε.
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Για να βοηθηθούμε στα επόμενα βήματα, πρέπει να ενεργοποιήσουμε κι άλλες έλξεις: Στα άκρα των αντικειμένων και στο πλησιέστερο σημείο επάνω στο αντικείμενο (βλ. διπλανή εικόνα).

Για το σχέδιο μας χρειαζόμαστε τώρα τον εσωτερικό κάθετο τοίχο με επαφές επάνω και κάτω ('Vert. Double Tee Wall').

Τον εισάγουμε και τον τοποθετούμε ακριβώς στην επάνω αριστερή γωνία, όπως στην παρακάτω εικόνα. Επίσης του αλλάζουμε το πάχος (είναι 100 mm και πρέπει να γίνει 200 mm).
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Τώρα που έχουμε τοποθετήσει σε γνωστό σημείο τον τοίχο, μπορούμε να τον μετακινήσουμε όσο θέλουμε. Ξέρουμε ότι η εσωτερική απόσταση των δύο τοίχων πρέπει να είναι 2,5 m. Το εργαλείο της μετακίνησης που θα ενεργοποιήσουμε, μετράει με σημείο αναφοράς τον κεντρικό άξονα του αντικειμένου. Άρα, θα πρέπει να τον μετακινήσουμε 2,5 m + 0,10 m (το μισό πάχος του εσωτερικού τοίχου).
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Ενεργοποιούμε το εργαλείο της μετακίνησης είτε από τα μενού είτε από την γραμμή εργαλείων.
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Επίσης, για να μπορέσουμε να ορίσουμε την απόσταση με το πληκτρολόγιο, πρέπει να εμφανίσουμε το παράθυρο των ιδιοτήτων (με το πλήκτρο F9).

Η μετακίνηση πρέπει να είναι σύμφωνα με τους υπολογισμούς μας 2,6 μέτρα. Σε ποιον άξονα; Στον οριζόντιο, τον Χ βέβαια. Άρα πληκτρολογούμε στο αντίστοιχο πεδίο του παραθύρου ιδιοτήτων 2,6 και επιβεβαιώνουμε με το πλήκτρο 'Enter' (ή την επιλογή 'Apply'). 
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Στην αριστερή εικόνα βλέπουμε το αποτέλεσμα της μετακίνησης. Αυτός ο εσωτερικός τοίχος πρέπει όμως να προεκταθεί μέχρι να φτάσει τον κάτω τοίχο. 
Αυτό μπορούμε να το πετύχουμε με δύο τρόπους:

1. [image: image73.png]


Μετακινώντας το άκρο με το ποντίκι: 'πιάνουμε' το άκρο από το κίτρινο σημαδάκι και με πατημένο το πλήκτρο 'Shift' το μετακινούμε μέχρι να φτάσει στον κάτω τοίχο και ενεργοποιηθεί η έλξη (έχουμε ενεργή την έλξη σε αντικείμενο, 'Geometry'). Το 'Shift' επιτρέπει μόνο την κάθετη μετακίνηση.

ή

2. Ορίζοντας το μήκος του τοίχου από το παράθυρο των ιδιοτήτων: Πληκτρολογούμε στο πεδίο 'Length' το μήκος αυτού του τοίχου: 4700mm.
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Ο τοίχος που έχει σειρά εισάγεται με τον ίδιο τρόπο.

1. Τον εισάγουμε και τον τοποθετούμε στην αριστερή επάνω γωνία
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2. Τον μετακινούμε 2,1 μέτρα προς τα κάτω, για να πετύχουμε εσωτερικές διαστάσεις του δωματίου 2,5m x  2m.

Αυτή ήταν η τελευταία κίνηση σχεδιασμού τοίχων.
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3.3 Πόρτες και παράθυρα

Τώρα ήρθε η σειρά να τοποθετήσουμε τις πόρτες και τα παράθυρα. Το πρόγραμμά μας διαθέτει διάφορους τύπους στον ίδιο κατάλογο με τους τοίχους.
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Στις δύο παρακάτω εικόνες βλέπουμε τα χαρακτηριστικά από δύο ενεργά σχήματα. Το ενεργό σχήμα διπλής πόρτας ('Double Door') έχει πλάτος 1,5m (1500 mm), ενώ της απλής πόρτας ('Single Door') έχει πλάτος 0,9m (900mm). Αν θέλουμε να αλλάξουμε το πλάτος μίας πόρτας, αρκεί να την επιλέξουμε και να πληκτρολογήσουμε το επιθυμητό πλάτος στο κατάλληλο κελί ('Width').
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Παρατηρούμε ότι αυτά τα ενεργά σχήματα έχουν κάποιες κίτρινες λαβές. Όταν τοποθετούμε μία πόρτα σε έναν τοίχο, αυτή προσανατολίζεται αυτόματα (ανάλογα από ποιά κατεύθυνση πλησιάσουμε τον τοίχο) και το άνοιγμα κόβεται αυτόματα. Οι βοηθητικές γραμμές όμως δεν προεκτείνονται, για να δείξουν σωστά το άνοιγμα στον τοίχο. 
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Η λαβή που βρίσκεται στο άνοιγμα της πόρτας, δίπλα στον οδηγό (το άλλο μικρό σύμβολο που εμφανίζεται) μας επιτρέπει να προεκτείνουμε τις κάθετες γραμμές προς τα κάτω. Αρκεί να το πιάσουμε και να το μετακινήσουμε προς τα κάτω. Μόλις πλησιάσουμε την εξωτερική γραμμή και ενεργοποιηθεί η έλξη στο αντικείμενο, αφήνουμε τη λαβή.

Αν επιλέξουμε μία πόρτα με το δεξί πλήκτρο του ποντικιού, θα βρούμε ορισμένες νέες επιλογές στο παράθυρο που ανοίγει. Ανάλογα με το είδος της πόρτας, μπορούμε να ζητήσουμε την αλλαγή στον τρόπο που ανοίγει:

· [image: image81.png]085m




προς τα αριστερά ή δεξιά ('Flip Hinge') και

· προς τα μέσα ή έξω ('Flip Swing').
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Στο παρακάτω σχέδιο δίνονται οι αποστάσεις ώστε να μπορούν να τοποθετηθούν οι πόρτες σωστά. Δίνονται δύο αποστάσεις για κάθε περίπτωση. Γιατί; Στο σχέδιο που αντιμετωπίζουμε καθημερινά, η απόσταση δίνεται από την άκρη της πόρτας. Για να μετακινήσουμε εμείς όμως την πόρτα χρειαζόμαστε την απόσταση από την μέση του ανοίγματός της. 

Σύμφωνα με τα παραπάνω, θα πρέπει 

1. να εισάγεις μία πόρτα από τον κατάλογό της στο σχέδιο

2. την τοποθετείς σε μία γωνία (από εκεί που μετράς την απόσταση)

3. την μετακινείς (move) ώστε να καταλήξει στον προορισμό της

4. τροποποιείς τις βοηθητικές γραμμές, για να διορθωθεί στο σχέδιο το άνοιγμα για την πόρτα

5. αντιγράφεις (μετακινείς με πατημένο το 'Shift') την πόρτα και στα άλλα σημεία (πρώτα σε μία γωνία και μετά την τοποθετείς στον προορισμό της)

6. καθορίζεις από πια πλευρά θα είναι οι μεντεσέδες και προς τα πού ανοίγει η κάθε πόρτα
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Αφού κάνεις τις παραπάνω κινήσεις, το σχέδιο θα πρέπει να έχει πάρει αυτή την μορφή:

Αφού έχουμε σχεδιάσει και τις πόρτες, ήρθε η σειρά των παραθύρων. Αυτά διάλεξε μόνος σου πού ακριβώς θα τα βάλεις και τι είδος θα χρησιμοποιήσεις. 

Τα παράθυρα μπαίνουν ακριβώς με τον ίδιο τρόπο όπως οι πόρτες. Ακόμα και το ίδιο σύμβολο μπορεί να χρησιμοποιηθεί σε ορισμένες περιπτώσεις.
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Η κάτοψη θα πρέπει να έχει τώρα πλέον την παρακάτω μορφή:

(Συνέχεια στο επόμενο κεφάλαιο)

3.4 Τα σύμβολα εσωτερικού χώρου

Στη βιβλιοθήκη 'Facilities' υπάρχουν μερικοί κατάλογοι με χρήσιμα για μας σύμβολα για να διαμορφώσουμε τον εσωτερικό χώρο. Ορισμένα από αυτά είναι τα παρακάτω (αριστερά το 'Seating' και δεξιά το 'Tables').
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Μία πρόταση για διαμόρφωση του χώρου είναι η παρακάτω:
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Άσκηση: Προσπάθησε να εισάγεις τα κατάλληλα ενεργά σχήματα και να δημιουργήσεις μία παρόμοια κάτοψη. Τα είδη υγιεινής θα τα βρεις στην βιβλιοθήκη 'Shared Catalogs', στον κατάλογο 'Restroom and Plumbing Fixtures'.

[image: image88.png]B

ol £



Σε αυτή τη φάση του σχεδιασμού, αποφασίζουμε να κάνουμε μια αλλαγή: Ο χώρος υποδοχής μπορεί να μεγαλώσει και να μικρήνει το WC. Πώς θα μετακινήσουμε όμως τον τοίχο; Για να μη σβήσουμε και ξανασχεδιάσουμε το κομμάτι που θέλει αλλαγή, μπορούμε να επιλέξουμε και να μετακινήσουμε μόνο ορισμένα αντικείμενα: 

1. Επιλέγουμε τον τοίχο

2. Κρατάμε το πλήκτρο 'Shift' πατημένο και επιλέγουμε την ντουλάπα και την πόρτα

3. Ενεργοποιούμε το εργαλείο της μετακίνησης (move).

4. Στο πεδίου του Υ-άξονα πληκτρολογούμε 0,3 m για να μετακινηθούν τα επιλεγμένα αντικείμενα κατά 30 cm προς τα επάνω.

Το τελικό αποτέλεσμα το βλέπουμε στο παρακάτω σχέδιο:
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3.5 Κείμενα
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Για να εισάγουμε ένα κείμενο στο σχέδιο μας, ακολουθούμε την παρακάτω διαδικασία:

1. Ενεργοποιούμε το εργαλείο κειμένου από το μενού 'Draw' > 'Text' ή από την γραμμή εργαλείων. 

2. Επιλέγουμε το σημείο όπου θέλουμε να γραφεί το κείμενο στο σχέδιο και πατάμε το αριστερό πλήκτρο του ποντικιού.

3. [image: image91.png]


Στο πλαίσιο που εμφανίζεται μπορούμε να πληκτρολογήσουμε το κείμενό μας. Αν θέλουμε να γραφεί με διαφορετική γραμματοσειρά, αρκεί να την επιλέξουμε από την γραμμή εργαλείων των ρυθμίσεων.

Πολλά ενεργά σχήματα διαθέτουν προετοιμασμένες θέσεις για κείμενο. Σε αυτή την περίπτωση, αρκεί να πατήσουμε δύο φορές γρήγορα το αριστερό πλήκτρο του ποντικιού πάνω στο ενεργό σχήμα και αυτόματα θα ανοίξει το πλαίσιο του κειμένου. Το ίδιο αποτέλεσμα έχουμε, αν επιλέξουμε το σχήμα με το δεξί πλήκτρο του ποντικιού και επιλέξουμε την επεξεργασία κειμένου ('Edit Text').

3.6 Η αποθήκευση του σχεδίου μας
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Αυτό το σχέδιο πρέπει να το αποθηκεύσουμε, επειδή θα το χρειαζόμαστε σε επόμενο κεφάλαιο. 

Η εντολή της αποθήκευσης βρίσκεται στο μενού 'File', αλλά και στη βασική γραμμή εργαλείων ('Standard').
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Αν έχουμε ήδη αποθηκεύσει μία φορά το σχέδιο που επεξεργαζόμαστε, οι παραπάνω εντολές δεν θα ανοίξουν κανένα παράθυρο. Αν είναι η πρώτη φορά που επιχειρούμε να το αποθηκεύσουμε, θα πρέπει να ορίσουμε ένα όνομα για το αρχείο. Για αυτό το λόγο, η εντολή της αποθήκευσης ανοίγει αυτόματα το παράθυρο της 'αποθήκευσης ως'.

Από αυτό το παράθυρο μπορούμε να επιλέξουμε και το είδος αρχείου που θα δημιουργηθεί ως βάση του σχεδίου μας.
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Στο πεδίο File name πληκτρολογούμε το όνομα του αρχείου. Αν θέλουμε να το αποθηκεύσουμε με άλλη μορφή, π.χ. για να το δώσουμε σε κάποιον που θα το δουλέψει με άλλο πρόγραμμα, μπορούμε να επιλέξουμε την μορφή του από την πιο κάτω λίστα επιλογής (Save as type). 

4 Σχεδιάζουμε - Τροποποιούμε

Αφού είδαμε τις βασικές ρυθμίσεις,  τη γενικότερη εμφάνιση του προγράμματος και τα έτοιμα σχήματα, ήρθε η στιγμή να σχεδιάσουμε με απλές γραμμές. Σε αυτό το κεφάλαιο θα μάθουμε να δουλεύουμε με τα σωστά εργαλεία, ώστε να πετύχουμε την ακρίβεια στο σχεδιασμό.

Εκτός από το να τοποθετούμε τις γραμμές στο σχέδιο, πρέπει να ξέρουμε και να τις τροποποιούμε, για να έχουμε το σωστό αποτέλεσμα. Πολλές φορές, παίρνουμε το τελικό αποτέλεσμα μετά την τροποποίηση ενός αντικειμένου. 

4.1 Εργαλεία σχεδιασμού XE "Εργαλεία σχεδιασμού" 
Τα εργαλεία σχεδιασμού είναι πολλά. Σε όλα τα σχεδιαστικά προγράμματα υπάρχουν εργαλεία για να σχεδιάσουμε γραμμές, κύκλους, τόξα και διάφορα άλλα βασικά σχήματα. Για να μπορέσει το πρόγραμμα να τοποθετήσει το σχήμα στην επιφάνεια σχεδιασμού, θα πρέπει να ορίσουμε τα βασικά του χαρακτηριστικά. Ένα ευθύγραμμο τμήμα π.χ. ορίζεται με τα δύο άκρα του, ένας κύκλος βάση του κέντρου και της ακτίνας του, αλλά και βάση τριών μη συνευθειακών σημείων (τρία σημεία που δεν βρίσκονται στην ίδια ευθεία).

Κάθε πρόγραμμα σχεδιασμού διαθέτει εργαλεία για τον σχεδιασμό ευθύγραμμων τμημάτων, τόξων, κύκλων και παραλληλογράμμων τουλάχιστον.

Και τα εργαλεία σχεδιασμού τα επιλέγουμε με δύο τρόπους:
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Α) Από το μενού Draw
Β) Από την γραμμή εργαλείων standard ή draw 

[image: image96.png]



Line XE "Line" :
Ευθύγραμμα τμήματα XE "Ευθύγραμμα τμήματα" 
Polyline XE "Polyline" :
Ένα πολύγραμμο XE "πολύγραμμο" , το οποίο αποτελείται από ευθύγραμμα τμήματα

Arc XE "Arc" : 
Τόξο XE "Τόξο"  (αν το επιλέξουμε από τα μενού, έχει τρεις επιλογές: να το σχεδιάσουμε ορίζοντας είτε τις δύο άκρες του, είτε το κέντρο, την ακτίνα και την γωνία του.

Spline XE "Spline" : 
Ομαλή καμπύλη XE "καμπύλη ομαλή" 
Rectangle XE "Rectangle" : 
Παραλληλόγραμμο XE "Παραλληλόγραμμο" 
Circle XE "Circle" : 
Κύκλος XE "Κύκλος" 
Text XE "Text" : 
Κείμενο XE "Κείμενο" 
Connector XE "Connector" : 
Αυτόματη γραμμή που ενώνει σχήματα

Για να σχεδιάσουμε ένα ευθύγραμμο τμήμα, επιλέγουμε το εργαλείο Line και κατόπιν καθορίζουμε την αρχή και το τέλος της, πατώντας το αριστερό κουμπί του ποντικιού στα συγκεκριμένα σημεία. Τα σημεία αυτά, τα ορίζουμε με διάφορους τρόπους:

Α) Πριν σχεδιάσουμε τη γραμμή: Οι έλξεις επιλέγουν συγκεκριμένα σημεία ενός αντικειμένου, είτε για αρχή είτε για τέλος.

Β) Αφού έχουμε σχεδιάσει τη γραμμή: Με το πλήκτρο F9 ενεργοποιείται το παράθυρο των ιδιοτήτων XE "παράθυρο των ιδιοτήτων"  (properties XE "properties" ) ενός αντικειμένου. Όταν πρόκειται για ευθύγραμμο τμήμα π.χ. μας εμφανίζει τις συντεταγμένες αρχής και τέλους, αλλά και το μήκος και τη γωνία του. Αυτές οι συντεταγμένες αλλάζουν. Αρκεί να τοποθετήσουμε τον δείκτη του ποντικιού μας στη συγκεκριμένη παράμετρο, να πατήσουμε το αριστερό πλήκτρο του και να πληκτρολογήσουμε την καινούργια τιμή.

4.2 Απλές τροποποιήσεις XE "τροποποιήσεις"  των βασικών αντικειμένων

Αν επιλέξουμε ένα αντικείμενο, εμφανίζονται λαβές XE "λαβές"  με διαφορετικά σύμβολα επάνω του. Ανάλογα με το είδος του αντικειμένου αυτές εμφανίζονται σε διάφορα σημεία. 
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Σε ένα τόξο εμφανίζονται στα δύο άκρα του πράσινα κουτάκια. Αν πιάσουμε ένα από αυτά και το μετακινήσουμε, μεταφέρεται αυτό το άκρο, ενώ το άλλο παραμένει σταθερό. Επίσης αλλάζει και το κέντρο του.
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Σε ένα ευθύγραμμο τμήμα, μπορούμε να αλλάξουμε το μήκος του, χωρίς να επηρεάσουμε την κλίση του. Αρκεί να μετακινήσουμε ένα από τα πράσινα τρίγωνα που εμφανίζονται στα δύο άκρα του. Τα πράσινα κουτάκια, οι λαβές, μας επιτρέπουν να μετακινήσουμε το συγκεκριμένο άκρο του.
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Στο παραλληλόγραμμο εμφανίζονται μικρά τετράγωνα σε όλες τις πλευρές του, επιτρέποντάς μας να του αλλάξουμε το μέγεθος σε όποια κατεύθυνση θέλουμε. Μετακινώντας το τρίγωνο που εμφανίζεται στη μία του γωνία, μπορούμε να μετατρέψουμε όλες τις γωνίες του σε τόξα.

4.3 Βασικές λειτουργίες - χειρισμοί
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Για να  XE "επιλογή:αντικειμένου" επιλέξουμε κάποια αντικείμενα, πρέπει να ακυρώσουμε πρώτα τυχόν ενεργοποιημένο εργαλείο σχεδιασμού πατώντας το πλήκτρο ESC ή πατώντας το εικονίδιο επιλογών (select XE "select" ).

Ένα αντικείμενο το επιλέγουμε απλά πηγαίνοντας το δείκτη του ποντικιού επάνω του και πατώντας το αριστερό του κουμπί. Αν θέλουμε να επιλέξουμε πολλά αντικείμενα, μπορούμε να κρατήσουμε το πλήκτρο 'shift' πατημένο και να τα επιλέξουμε ένα ένα ή να επιλέξουμε την περιοχή, μέσα στην οποία βρίσκονται τα αντικείμενα. 
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Όταν θέλουμε να σβήσουμε XE "διαγραφή:αντικειμένου"  ένα σχεδιασμένο αντικείμενο, απλά το επιλέγουμε και πατάμε το πλήκτρο DEL (ή Delete XE "Delete" ).

Αυτήν τη λειτουργία θα τη βρούμε και στο μενού edit.
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Πολύ χρήσιμη είναι η δυνατότητα του undo XE "undo" , δηλαδή η ακύρωση XE "ακύρωση"  της τελευταίας μας κίνησης. Ενεργοποιείται από το μενού 'edit' ή με το εικονίδιο 

Μόλις κάνουμε μία λάθος κίνηση, επιλέγουμε την ακύρωσή της, επαναφέροντας έτσι γρήγορα το σχέδιο στην προηγούμενη κατάσταση.

Με το πλήκτρο F9 ενεργοποιούμε το παράθυρο των ιδιοτήτων XE "ιδιότητες αντικειμένων"  των αντικειμένων (Property Window XE "Property Window" ). 

Όταν επιλέξουμε ένα αντικείμενο, στο παράθυρο των ιδιοτήτων του, μπορούμε να ελέγξουμε τα χαρακτηριστικά του. Αυτό το παράθυρο ενεργοποιείται και από το μενού view XE "view" .

Από το ίδιο μενού μπορούμε να ελέγξουμε την εμφάνιση κι άλλων βοηθητικών εργαλείων, όπως του χάρακα, του καννάβου και των γραμμών εργαλείων.
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Αν θέλουμε να αντιγράψουμε XE "αντιγραφή"  ένα ήδη σχεδιασμένο αντικείμενο, απλά κρατάμε πατημένο το πλήκτρο ctrl και σέρνουμε το αντικείμενο σε κάποια απόσταση από την αρχική του θέση.

Το πλήκτρο shift XE "shift"  μας βοηθάει στο σχεδιασμό, ώστε οι μετακινήσεις γίνονται μόνο σε συγκεκριμένους άξονες ή γωνίες.

Μπορούμε να ρυθμίσουμε το πρόγραμμα έτσι ώστε ένα εργαλείο σχεδιασμού να παραμένει ενεργό μέχρι να επιλέξουμε άλλο εργαλείο ή να λειτουργεί μόνο για μία κίνηση. Αυτό γίνεται στο μενού File > Options'
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Έχουμε την δυνατότητα να ρυθμίσουμε τα εργαλεία μας με τέτοιο τρόπο, ώστε να παραμένουν ενεργά και μετά την πρώτη εφαρμογή τους. Σε αυτή την περίπτωση θα πρέπει να τα ακυρώνουμε με το πλήκτρο 'ESC' ή ενεργοποιώντας ένα άλλο εργαλείο.

4.4 Εργαλεία τροποποίησης σχημάτων XE "τροποποίηση σχημάτων" 
Για να μπορέσουμε να συνθέσουμε ένα πολύπλοκο σχέδιο, σχεδιάζουμε με τα εργαλεία που μας δίνει το πρόγραμμα που δουλεύουμε και τα τροποποιούμε έτσι ώστε να έχουμε το επιθυμητό αποτέλεσμα. 

Μερικά από τα βασικά εργαλεία τροποποίησης σχημάτων αφορούν το κόψιμο γραμμών σε συγκεκριμένα σημεία, την αντιγραφή, τη μετακίνηση, τη μεγέθυνση ή σμίκρυνση, την περιστροφή τους και την παράλληλη αντιγραφή τους.

Στην ομάδα εργαλείων τροποποίησης αντικειμένων συμπεριλαμβάνονται και αυτά, τα οποία μας επιτρέπουν την ευθυγράμμιση αλλά και την τοποθέτησή τους ανά συγκεκριμένα διαστήματα. 
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Ορισμένα από τα εργαλεία είναι:
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Move XE "Move" : Μετακινεί ένα αντικείμενο ή μία επιλογή αντικειμένων. Επιλέγουμε το ή τα αντικείμενα, μετά το εργαλείο και τα μετακινούμε.

Rotate XE "Rotate" : Περιστρέφει ένα ή μία επιλογή αντικειμένων. Επιλέγουμε το ή τα αντικείμενα, μετά το εργαλείο και τα περιστρέφουμε. Έχουμε τη δυνατότητα να μετακινήσουμε τον άξονα περιστροφής, πριν ξεκινήσουμε την περιστροφή.

Scale XE "Scale" : Μεγέθυνση των επιλεγμένων σχημάτων. Επιλέγουμε το ή τα αντικείμενα, μετά το εργαλείο και τα μεγεθύνουμε. Μπορούμε να μετακινήσουμε το κεντρικό σημείο, γύρω από το οποίο γίνεται η μεγέθυνση.

Mirror XE "Mirror" : Καθρεφτίζει βάσει άξονα συμμετρίας. Αφού επιλέξουμε τα αντικείμενα και ενεργοποιήσουμε το εργαλείο, ορίζουμε τον άξονα συμμετρίας.

Split XE "Split" : Κόβει ένα αντικείμενο (γραμμή, καμπύλη κ.λπ.) στο επιλεγμένο σημείο (δουλεύουμε με έλξεις). Επιλέγουμε πρώτα το εργαλείο και μετά το σημείο επάνω στο αντικείμενο.
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Trim XE "Trim" : Κόβει το κομμάτι ενός αντικειμένου, το οποίο τέμνεται από ένα άλλο, ακριβώς στο σημείο τομής και το σβήνει από την πλευρά που επιλέξαμε. Αφού ενεργοποιήσουμε το εργαλείο αυτό, επιλέγουμε τα κομμάτια, τα οποία θέλουμε να σβήσουν.

Extend XE "Extend" : Προεκτείνει μία γραμμή μέχρι μία άλλη. Με ενεργοποιημένο το εργαλείο επιλέγουμε τη γραμμή που θέλουμε να προεκταθεί μέχρι να βρει μία άλλη.

Fillet XE "Fillet" : Συνδέει δύο γραμμές με ένα τόξο συγκεκριμένης ακτίνας. Πρώτα επιλέγουμε τις δύο γραμμές και μετά ενεργοποιούμε το εργαλείο αυτό. Αμέσως εμφανίζεται ένα μικρό τρίγωνο, με το οποίο ρυθμίζουμε την ακτίνα του τόξου.

Offset XE "Offset" : Δημιουργεί ένα νέο αντικείμενο παράλληλα και σε συγκεκριμένη απόσταση από το πρωτότυπό του.

Όλα τα παραπάνω εργαλεία μπορούν να ρυθμιστούν με το ποντίκι επάνω στο σχέδιο. 

Μερικά από τα παραπάνω εργαλεία ενεργοποιούνται και πατώντας το δεξί πλήκτρο του ποντικιού επάνω στο αντικείμενο.
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Ορισμένα από αυτά επιτρέπουν τη ρύθμισή τους και με το παράθυρο των ιδιοτήτων. Εκεί μπορούμε να ορίσουμε τις παραμέτρους της τροποποίησης.

Παραδείγματα τροποποιήσεων:

1. Το παρακάτω ευθύγραμμο τμήμα να περιστραφεί γύρω από τον άξονά του κατά 30(. 
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α) Με τη χρήση των ιδιοτήτων του αντικειμένου:

Επιλέγουμε το αντικείμενο. Στο παράθυρο των ιδιοτήτων του βλέπουμε όλα τα στοιχεία του. Μπορούμε να αλλάξουμε τη γωνία του προσθέτοντας στις 45( τις 30( και αντικαθιστώντας το 45 με το αποτέλεσμα (75().

β) Με τη χρήση της εντολής περιστροφής (rotate)
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Επιλέγουμε, με τη σειρά, πρώτα το αντικείμενο που θέλουμε να περιστρέψουμε και μετά το εργαλείο περιστροφής [image: image6.png]


 (ή πατάμε το δεξί πλήκτρο του ποντικιού). Το παράθυρο ιδιοτήτων του αντικειμένου αλλάζει και εμφανίζονται μόνο οι παράμετροι που αφορούν την περιστροφή: η γωνία (πληκτρολογούμε 60(), οι συντεταγμένες του κέντρου περιστροφής και ο αριθμός των αντιγράφων. Μπορούμε να ορίσουμε άλλο κέντρο περιστροφής είτε πληκτρολογώντας τις συντεταγμένες, είτε μετακινώντας το κίτρινο σύμβολο που εμφανίζεται στο αντικείμενο. Αν πληκτρολογήσουμε και αριθμό αντιγράφων, τότε γίνονται τόσες περιστροφές, όσα αντίγραφα ορίσαμε και η διαφορά της γωνίας μεταξύ τους είναι η γωνία περιστροφής

[image: image111.png]


Αν στο συγκεκριμένο παράδειγμα πληκτρολογήσουμε 3 αντίγραφα με 30( γωνία και κέντρο περιστροφής το κάτω άκρο του ευθύγραμμου τμήματος, το αποτέλεσμα θα είναι:

γ) Με τη χρήση του ποντικιού
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Επιλέγουμε το αντικείμενο και το εργαλείο περιστροφής. Κρατάμε το αριστερό πλήκτρο του ποντικιού πατημένο επάνω στο ένα άκρο του αντικειμένου και το περιστρέφουμε. Αν κρατήσουμε και το πλήκτρο 'shift' ταυτόχρονα πατημένο, το αντικείμενο μετακινείται με βήμα 15(. Για να δημιουργήσουμε αντίγραφα, μπορούμε να κρατήσουμε πατημένο και το πλήκτρο 'control'.

2. Τα εργαλεία trim και extend
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Δημιούργησε ένα σχέδιο σαν το παρακάτω (η ακρίβεια δεν μας ενδιαφέρει σε αυτό το παράδειγμα).

Θα δοκιμάσουμε τα εργαλεία trim (κόβει) και Extend (προεκτείνει). Και τα δύο ενεργοποιούν μία έλξη, για να μπορούμε να ορίσουμε πιο εύκολα το αντικείμενο που θέλουμε να επεξεργαστούμε.
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Ενεργοποιούμε το εργαλείο 'Trim' από το μενού 'Modify' > 'Trim' ή από την αντίστοιχη γραμμή εργαλείων.
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Επιλέγουμε το κομμάτι που θέλουμε να κόψουμε. Παρατηρούμε ότι ακόμα και αν δεν έχουμε ενεργοποιημένη την έλξη στα αντικείμενα, αυτή εμφανίζεται αυτόματα. Πατάμε το αριστερό πλήκτρο του ποντικιού και
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3. ... το αποτέλεσμα είναι να κοπεί το κομμάτι που επιλέξαμε μέχρι εκεί που τέμνει μία άλλη γραμμή.

Τώρα θέλουμε να κόψουμε το κομμάτι ανάμεσα στις δύο γραμμές.
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1. Αρκεί να πάμε με τον δείκτη του ποντικιού μας ακριβώς σε εκείνο το κομμάτι, οπότε εμφανίζεται πάλι η έλξη (το εργαλείο 'Trim' θα πρέπει να είναι ενεργό!).
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2. Μόλις το επιλέξουμε αυτό κόβεται. 

Παρατηρούμε ότι πάντα κόβεται η γραμμή που επιλέγουμε μέχρι το σημείο όπου θα συναντήσει μία άλλη γραμμή.

Για να προεκτείνουμε μία γραμμή ακολουθούμε την ίδια διαδικασία.
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Ενεργοποιούμε το εργαλείο Extend.
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2. Επιλέγουμε την γραμμή που θέλουμε να προεκτείνουμε.

3. [image: image121.png]


Η γραμμή προεκτείνεται μέχρι να συναντήσει μία άλλη.

Με παρόμοιο τρόπο λειτουργούν και τα υπόλοιπα εργαλεία τροποποιήσεων.

5 Τα πρώτα βήματα στο σχεδιασμό

Σε αυτό το κεφάλαιο θα αρχίσουμε να σχεδιάζουμε δικά μας αντικείμενα. Ξεκινώντας με απλά σχέδια, θα δούμε τις βασικές λειτουργίες και εργαλεία σχεδιασμού. Στην πορεία θα δημιουργήσουμε πρότυπα σχέδια (με όλες τις ρυθμίσεις) και θα φορτώσουμε διάφορες βιβλιοθήκες ενεργών σχεδίων.

5.1 Οι αρχικές ρυθμίσεις
UNITS - SCALE - GRID
Στον υπολογιστή έχουμε, ανά πάσα στιγμή, την δυνατότητα να τροποποιήσουμε τα σχέδιά μας πολύ γρήγορα. Προσπαθούμε όμως να κερδίσουμε χρόνο κάνοντας κάποιες ρυθμίσεις από την αρχή. 

Αφού ξεκινήσουμε το πρόγραμμα, επιλέγουμε το πρότυπο Blank Template. Αυτό δε φορτώνει καμία βιβλιοθήκη και δεν κάνει καμία ρύθμιση.

Αν θέλουμε να ελέγχουμε την πορεία του σχεδίου και την μελλοντική του εμφάνιση στο χαρτί, θα πρέπει από την αρχή να ορίσουμε τον εκτυπωτή και το χαρτί εκτύπωσης. Για τα επόμενα παραδείγματα χρειαζόμαστε τις παρακάτω ρυθμίσεις:

Μέγεθος χαρτιού (page setup): 
Α4

Μονάδες μέτρησης (units): σχέδιο: 
m
πάχος γραμμών:
mm
Κλίμακα (scale): 
1:100

Κάνναβος (grid): 
ανά 10 cm
5.2 Χρήσιμοι κατάλογοι ενεργών σχημάτων

Ανάλογα με το σχέδιο που έχουμε να κάνουμε, μπορούμε να φορτώσουμε διάφορους καταλόγους έτοιμων συμβόλων. Αυτά τα σύμβολα είναι οργανωμένα σε φακέλους, βιβλιοθήκες. Για τα επόμενα παραδείγματα θα χρειαστούμε τους παρακάτω καταλόγους: 

Από τον φάκελο shared catalogs:

· Walls, Doors and Windows (τοίχοι, πόρτες, παράθυρα)

· Annotations (παρατηρήσεις, διαστάσεις)

· Restroom and Plumbing Fixtures (είδη υγιεινής)

· Basic Activeshapes (βασικά ενεργά σχήματα)

· Architecture (αρχιτεκτονικά σύμβολα)

5.3 Δημιουργία πρότυπων σχεδίων

Πολλά από τα σχέδια μας έχουν ίδιες ρυθμίσεις. Αλλά και διάφορα άλλα βοηθήματα είναι κοινά μεταξύ τους. Θα μπορούσαμε να ετοιμάσουμε ένα σχέδιο, με όλες τις βασικές ρυθμίσεις (μονάδα μέτρησης, κλίμακα κ.λπ.) και τα υπόλοιπα κοινά βοηθήματα (στρώσεις, ενεργά σχήματα κ.λπ.). Αυτό το σχέδιο θα μπορούσαμε να το χρησιμοποιούμε ως αρχή κάθε φορά. Θα είχαμε πιθανώς ένα πρόβλημα μόνο: τη στιγμή που το αποθηκεύουμε, θα πρέπει να του αλλάξουμε όνομα, διότι αλλιώς διαγράφει την προηγούμενη έκδοσή του και έτσι το χάνουμε ως πρότυπο σχέδιο. Ακριβώς για αυτό το λόγο υπάρχει μία ειδική μορφή αποθήκευσης του σχεδίου μας: το πρότυπο XE "πρότυπο"  (template XE "template" ).
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Η μορφή 'πρότυπο σχέδιο' έχει την ιδιότητα να αποθηκεύει το κανονικό σχέδιο με άλλο όνομα. Μόλις δώσουμε την εντολή αποθήκευσης (save), το πρόγραμμα μάς ζητάει το όνομα του σχεδίου για την αποθήκευσή του. 

Το πεδίο όπου πληκτρολογούμε το όνομα είναι υπερφωτισμένο (μπλε) και εδώ πρέπει να πληκτρολογήσουμε το όνομα του σχεδίου μας. Η επιλογή ακριβώς από κάτω είναι για το είδος του αρχείου που θα δημιουργηθεί. Εμείς, επειδή θέλουμε ένα πρότυπο σχέδιο, θα πρέπει να επιλέξουμε Actrix Template. Ολοκληρώνουμε την εντολή επιλέγοντας την αποθήκευση (save). Αν έχουμε κάνει λάθος, μπορούμε να ακυρώσουμε αυτή την διαδικασία, αντί να την επιβεβαιώσουμε. Αυτό γίνεται με την επιλογή της ακύρωσης (cancel).
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5.4 Το πρώτο μας σχέδιο

Θέλουμε να σχεδιάσουμε ένα νεροχύτη
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Οι μόνες διαστάσεις που μας ενδιαφέρουν για το συγκεκριμένο σχέδιο είναι οι εξωτερικές του διαστάσεις: 1,2m x 0,7m.
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1. Σχεδιάζουμε ένα παραλληλόγραμμο με τις εξωτερικές διαστάσεις.
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Σχεδιάζουμε ένα μικρότερο παραλληλόγραμμο μέσα στο πρώτο. Οι διαστάσεις του και η τοποθέτησή του δε χρειάζεται να γίνουν με ακρίβεια.
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3. Σχεδιάζουμε μία οριζόντια γραμμή (πατημένο το πλήκτρο 'Shift') και σταματάμε το εργαλείο (πλήκτρο 'ESC').
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4. Επιλέγουμε την γραμμή που σχεδιάσαμε , ενεργοποιούμε το εργαλείο της μετακίνησης ('move') και ορίζουμε την μετακίνηση στον Υ-άξονα  -0,8m και 5 αντίγραφα.

5. [image: image129.png]


Μόλις επιβεβαιώσουμε τις παραπάνω ρυθμίσεις, αντιγράφεται η πρώτη γραμμή και δημιουργούνται άλλες 5 από κάτω της.

Ολοκληρώθηκε ο σχεδιασμός του νεροχύτη. Αποθηκεύουμε το σχέδιο, γιατί χρειάζεται σε επόμενο κεφάλαιο.

5.5 Ιδιότητες αντικειμένων

Όπως είδαμε και σε προηγούμενη άσκηση, όλα τα βασικά αντικείμενα που σχεδιάζουμε έχουν κάποιες ιδιότητες. Αυτές, ανάλογα με το αντικείμενο, μπορεί να είναι:

· Χρώμα γραμμής XE "Χρώμα γραμμής"  (Line color)
· Χρώμα γεμίσματος XE "Χρώμα γεμίσματος"  (Fill color)
· Χρώμα διαγράμμισης XE "Χρώμα διαγράμμισης"  (Pattern color)
· Πάχος γραμμής XE "Πάχος γραμμής"  (Line Weight)
· Είδος γραμμής XE "Είδος γραμμής"  (Line Pattern)
· Είδος διαγράμμισης XE "Είδος διαγράμμισης"  (Fill Pattern)
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Έχουμε διάφορους τρόπους για να αλλάξουμε κάποια από αυτές τις ιδιότητες. Ο πιο εύκολος και άμεσος τρόπος είναι από την γραμμή εργαλείων 'format'.

Αυτές οι ιδιότητες υπάρχουν και στο παράθυρο των ιδιοτήτων (property window). Και στις δύο περιπτώσεις, θα πρέπει πρώτα να επιλέξουμε το αντικείμενο και μετά την ιδιότητα, που θέλουμε να του δώσουμε.

Πατώντας το δεξί πλήκτρο του ποντικιού την στιγμή που ο δείκτης του βρίσκεται πάνω στο αντικείμενο, ανοίγει ένα παράθυρο, το οποίο μας επιτρέπει να κάνουμε διάφορες ρυθμίσεις. Μεταξύ αυτών των ρυθμίσεων υπάρχουν και κάποιες που ανοίγουν αμέσως το παράθυρο των ιδιοτήτων στην συγκεκριμένη επιλογή. Αν π.χ. θέλουμε να αλλάξουμε το γέμισμα του αντικειμένου, απλά επιλέγουμε 'fill'. Αμέσως ανοίγει το παράθυρο ιδιοτήτων (αν δεν ήταν ήδη στην οθόνη μας) και μάλιστα στις επιλογές που αφορούν το γέμισμα.

Τα κείμενα έχουν και τις δικές τους ιδιότητες (γραμματοσειρά, μέγεθος, μορφή κ.λπ.)

Όταν σχεδιάζουμε τα διάφορα αντικείμενα, αυτά δημιουργούνται με μια ιεραρχία XE "ιεραρχία"  (draw order). Το πρώτο σχεδιασμένο είναι ταυτόχρονα και πρώτο στην σειρά. Το τελευταίο σχεδιασμένο είναι και τελευταίο στη σειρά. Αυτό παίζει ρόλο στις επιλογές για τροποποιήσεις, αλλά και στην εμφάνιση των αντικειμένων που καλύπτονται. Τα πιο πρόσφατα σχεδιασμένα καλύπτουν τα πιο παλιά.

Στο παρακάτω σχέδιο, έχουν τοποθετηθεί με τη σειρά:

1. το τετράγωνο

2. ο κύκλος και
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το τρίγωνο.

Αν τα επιλέξουμε όλα μαζί (ανοίγοντας ένα παράθυρο γύρω απ' όλα) θα δούμε ότι το τελευταίο σχεδιασμένο αντικείμενο (εδώ είναι το τρίγωνο) θα αποκτήσει πράσινες λαβές, ενώ τα υπόλοιπα θα έχουν μπλε. Σε ορισμένες τροποποιήσεις, στις οποίες χρειάζεται ένα βασικό αντικείμενο, βάσει του οποίου θα γίνει μία τροποποίηση, χρησιμοποιείται το συγκεκριμένο. 

Για να στείλουμε ένα αντικείμενο πίσω από κάποιο άλλο ή μπροστά από αυτό, υπάρχουν ειδικές εντολές στην γραμμή εργαλείων 'arrange', οι οποίες κάνουν αυτές τις μετακινήσεις.
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Αν επιλέξουμε τον κύκλο και δώσουμε την εντολή αποστολής πιο πίσω ('send backward'), θα έχουμε το παρακάτω αποτέλεσμα:

Η διαφορετική εμφάνιση των λαβών, σε επιλεγμένα αντικείμενα, γίνεται μόνο όταν επιλεγούν περισσότερα αντικείμενα. Όταν επιλέγουμε ένα αντικείμενο, οι λαβές σ' αυτό είναι πράσινες.

5.6 Ευθυγράμμιση αντικειμένων XE "Ευθυγράμμιση αντικειμένων" 
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Αν έχουμε σχεδιάσει ορισμένα αντικείμενα και θέλουμε να τα ευθυγραμμίσουμε σε κάποιον άξονα, αρκεί να χρησιμοποιήσουμε τα εργαλεία align από την γραμμή εργαλείων arrange.

Όταν επιλέξουμε ορισμένα αντικείμενα ανοίγοντας ένα παράθυρο γύρω τους, το πιο πρόσφατα σχεδιασμένο θα έχει πράσινες λαβές και τα υπόλοιπα μπλε. Αυτό θα χρησιμοποιηθεί και ως αναφορά για την επικείμενη τροποποίηση, ευθυγράμμιση. Αν θέλουμε να αλλάξουμε το αντικείμενο, βάσει του οποίου θα γίνει η τροποποίηση, αρκεί να το επιλέξουμε πρώτο και μετά να προσθέσουμε στις επιλογές μας (με το πλήκτρο 'shift' πατημένο) τα υπόλοιπα.
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Για το παρακάτω παράδειγμα θα χρησιμοποιήσουμε τα προηγούμενα αντικείμενα, με την ίδια σειρά σχεδιασμένα. Έστω ότι είναι τοποθετημένα με την παρακάτω διάταξη:
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Αφού επιλέξουμε όλα τα αντικείμενα, βλέπουμε ότι το τρίγωνο έχει πράσινες λαβές, ενώ τα άλλα δύο μπλε. Έτσι καταλαβαίνουμε, ότι η κάθετη ευθυγράμμιση, θα μετακινήσει το τετράγωνο και τον κύκλο.
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Η οριζόντια ευθυγράμμιση θα είχε τα παρακάτω αποτελέσματα:
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Εκτός από τα εργαλεία ευθυγράμμισης, υπάρχουν και αυτά της διανομής XE "διανομή" . Αν θέλουμε τα παρακάτω αντικείμενα να έχουν ίσες αποστάσεις μεταξύ τους στον οριζόντιο άξονα, αρκεί να επιλέξουμε το εργαλείο 'Distribute Center'. Το αποτέλεσμα θα είναι το παρακάτω:
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Μετακινήθηκε ο κύκλος προς τα δεξιά, έτσι ώστε να απέχει στον οριζόντιο άξονα την ίδια απόσταση από τα δύο άλλα αντικείμενα.

Αν επιλέξουμε 'Distribute Middle', το αποτέλεσμα θα είναι το παρακάτω:
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Σ' αυτή την περίπτωση μετακινήθηκε το τρίγωνο, για να απέχει στον κάθετο άξονα ίσες αποστάσεις από τα άλλα δύο αντικείμενα.

Βέβαια μπορούμε να δώσουμε αυτές τις εντολές και διαδοχικά, ανάλογα πάντα με το επιθυμητό αποτέλεσμα. Αν στο τελευταίο παράδειγμα επιλέξουμε και το Distribute Center, το αποτέλεσμα θα είναι:

[image: image140.png][t Doos, andvindons

L«

8 W&
v o
™ ™1
-~ ~A

Single Biold Door _ Double Bifold Door

H

EE





6 Βιβλιοθήκες έτοιμων συμβόλων

Όπως είδαμε και σε προηγούμενο κεφάλαιο, υπάρχουν βιβλιοθήκες XE "βιβλιοθήκες"  έτοιμων συμβόλων, τα οποία μπορούμε να εισάγουμε στο σχέδιό μας. 

Σε αυτό το κεφάλαιο θα μάθουμε να δημιουργούμε και δικά μας σύμβολα, να τα τροποποιούμε και να τα εισάγουμε στο σχέδιο.

6.1 Κατάλογοι XE "Κατάλογοι"  ενεργών σχημάτων

Στο πρόγραμμά μας τα έτοιμα σύμβολα ονομάζονται ενεργά σχήματα (ActiveShapes), επειδή μπορούν να έχουν κάποιους αυτοματισμούς στην τοποθέτηση αλλά και στην εμφάνισή τους. Αυτά τα σύμβολα είναι ομαδοποιημένα σε καταλόγους, ανάλογα με το είδος τους. Οι κατάλογοι με την σειρά τους είναι αρχειοθετημένοι σε βιβλιοθήκες, σύμφωνα με την κατηγορία τους. 

Για να εισάγουμε ένα ενεργό σχήμα στο σχέδιό μας, θα πρέπει να το αναζητήσουμε στον κατάλογο όπου περιλαμβάνεται. Τον κατάλογο αυτό θα τον βρούμε στην βιβλιοθήκη της κατηγορίας του.

Έστω πως θέλουμε να εισάγουμε στο σχέδιό μας μία πόρτα. Οι πόρτες βρίσκονται στον κατάλογο 'Walls, Doors and Windows', ο οποίος βρίσκεται στη βιβλιοθήκη 'Shared Catalogs'. Για να αναζητήσουμε ένα σύμβολο στην βιβλιοθήκη, θα πρέπει να πάμε μέσω του πτυσσόμενου μενού File > Catalog στις επιλογές του. Αν έχουμε ήδη ανοίξει το παράθυρο εμφάνισης των συμβόλων (content explorer) με το πλήκτρο F8, μπορούμε να επιλέξουμε το εικονίδιο 'open catalog'. Και στις δύο περιπτώσεις, ανοίγει το παρακάτω παράθυρο:
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Στη βιβλιοθήκη (φάκελο) Shared Catalogs, θα βρούμε ορισμένους καταλόγους ενεργών σχημάτων, μεταξύ των οποίων είναι και ο ζητούμενος.
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Ανοίγουμε τον κατάλογο που χρειαζόμαστε και αμέσως εμφανίζονται, στο παράθυρο των ενεργών σχημάτων (content explorer), όλα τα σχήματα που περιέχονται σ' αυτόν.
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Για να εισάγουμε ένα ενεργό σχήμα, αρκεί να κρατήσουμε το αριστερό πλήκτρο του ποντικιού πατημένο επάνω του και να το σύρουμε στο σχέδιο στη θέση που θέλουμε.

6.2 Δημιουργία XE "Δημιουργία"  ενεργών σχημάτων

Για να δημιουργήσουμε ένα ενεργό σχήμα ακολουθούμε τα παρακάτω βήματα:
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1. Σχεδιάζουμε το αντικείμενο.

2. [image: image145.png]


Επιλέγουμε όλα τα επιμέρους αντικείμενα.

3. [image: image146.png]


Επιλέγουμε την εντολή Make ActiveShape, την οποία θα βρούμε στο μενού Tools ή στην γραμμή εργαλείων Edit Shape.

4. [image: image147.png]


Στην προτροπή για επιλογή ενός από τα τρία είδη ενεργού σχήματος, διαλέγουμε αυτό που ταιριάζει. Οι επιλογές είναι:


α) Σαν μία γραμμή με δύο άκρα (Like a line with two endpoints)
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Το αποτέλεσμα είναι ένα ενεργό σχήμα με τέσσερις λαβές. Επιλέγοντας μία από τις κίτρινες (αριστερά και δεξιά), μπορούμε να μετακινήσουμε και να παραμορφώσουμε το σχήμα, ενώ η άλλη παραμένει σταθερή. Οι δύο πράσινες λαβές επιτρέπουν την αλλαγή μεγέθους του σχήματος.
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β) Σαν ένα παραλληλόγραμμο με σταθερό μέγεθος (Like a rectangle with a fixed size)

Το αποτέλεσμα είναι ένα ενεργό σχήμα, του οποίου το μέγεθος δεν μπορεί να αλλάξει.
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γ) Σαν ένα παραλληλόγραμμο, το οποίο μπορεί να μεγεθυνθεί (Like a rectangle that can be stretched and scaled)

Το ενεργό σχήμα που δημιουργείται μπορεί να αλλάξει μέγεθος σε όλες τις κατευθύνσεις. 

Αυτό είναι το πρώτο στάδιο της δημιουργίας ενός ενεργούς σχήματος. Μπορούμε να το επεξεργαστούμε πιο πολύ με το εργαλείο τροποποίησης σχημάτων.

6.3 Τροποποίηση ενεργών σχημάτων
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Αφού έχουμε δημιουργήσει ένα ενεργό σχήμα, μπορούμε να το τροποποιήσουμε, αρκεί να το επιλέξουμε και να ενεργοποιήσουμε την εντολή 'Edit Activeshape' από το μενού 'Tools' ή από την γραμμή εργαλείων 'Edit ActiveShape'.
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Έχουμε τη δυνατότητα να προσθέσουμε δύο ειδικά βοηθήματα στο ενεργό σχήμα: 

· τους οδηγούς ('Plugs') και

· τις υποδοχές ('Sockets').

Αυτά τα βοηθήματα, προσδίδουν στο ενεργό σχήμα κάποιες επιπλέον δυνατότητες, αυτοματισμούς. Όταν τοποθετηθούν σε ένα σχήμα, εμφανίζονται τη στιγμή που μετακινείται αυτό και βοηθούν στη σωστή τοποθέτησή του.
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Παράδειγμα (συνέχεια): Νεροχύτης

Θέλουμε να δημιουργήσουμε ένα ενεργό σχήμα: τον νεροχύτη που σχεδιάσαμε σε προηγούμενο κεφάλαιο

Αρχικά ανοίγουμε το σχέδιο που έχουμε αποθηκεύσει.

Αφού έχει εμφανιστεί το σχέδιό μας ξεκινάμε την διαδικασία δημιουργίας ενεργού σχήματος:

1. [image: image154.png]


Επιλέγουμε όλο το σχήμα (τον νεροχύτη).
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2. Πατάμε το εικονίδιο δημιουργίας ενεργού σχήματος.
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3.  Στο παράθυρο που εμφανίζεται, θα πρέπει να επιλέξουμε τον τρόπο διαχείρισης αυτού του σχήματος. Εμείς επιλέγουμε 'σαν παραλληλόγραμμο...', σύμφωνα με την διπλανή εικόνα.
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4. Μόλις επιβεβαιώσουμε με 'ΟΚ' ολοκληρώνεται η μετατροπή σε ενεργό σχήμα.

Με τις παραπάνω κινήσεις μετατρέψαμε ένα σχήμα που αποτελείται από πολλά αντικείμενα (παραλληλόγραμμα, ευθύγραμμα τμήματα) σε ένα ενεργό σχήμα (ActiveShape). Τώρα πρέπει να δημιουργήσουμε έναν καινούργιο κατάλογο, στον οποίο θα αποθηκευτεί αυτό το σχήμα και τον οποίο μπορούμε να εμπλουτίσουμε στο μέλλον.

Ακολουθούμε τα παρακάτω βήματα για να δημιουργήσουμε έναν κατάλογο με το ενεργό σχήμα που δημιουργήσαμε.

1. [image: image158.png]


Δημιουργούμε έναν καινούργιο κατάλογο επιλέγοντας το αντίστοιχο εικονίδιο από το παράθυρο των ενεργών σχημάτων.
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2. Βλέπουμε πως δημιουργήθηκε ένας κατάλογος με αρχικό όνομα 'Catalog2' (το 2 είναι αύξων αριθμός), αλλά είναι άδειος.
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3. Τώρα αρκεί να μεταφέρουμε το σχήμα μας (τον νεροχύτη) μέσα στον κατάλογο. Το πιάνουμε και το σέρνουμε στην ελεύθερη επιφάνεια. Αμέσως δημιουργείται ένα εικονίδιο, με όνομα 'Item1'. 
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Τώρα πρέπει να αλλάξουμε το όνομα του ενεργού σχήματός μας. Το επιλέγουμε και μετά από λίγο (1-2 δευτερόλεπτα) ξαναπατάμε το αριστερό πλήκτρο του ποντικιού επάνω στο όνομά του. Το όνομά του υπερφωτίζεται και μπορούμε να πληκτρολογήσουμε το καινούριο.
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Μέχρι στιγμής, το ενεργό σχήμα είναι μέρος του σχεδίου μας και ο κατάλογός του προσωρινός. Θα πρέπει να τα αποθηκεύσουμε και σε μία βιβλιοθήκη στον σκληρό μας δίσκο. Ξεκινάμε την διαδικασία πατώντας στο αντίστοιχο εικονίδιο.
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6. Στο παράθυρο που ανοίγει και μοιάζει με αυτό της αποθήκευσης σχεδίων, μεταφερόμαστε στην βιβλιοθήκη, στην οποία θέλουμε να αποθηκευτεί ο κατάλογος και 
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7. ... πληκτρολογούμε ένα όνομα γι' αυτόν. Επιβεβαιώνουμε όπως πάντα πατώντας στο Save (αποθήκευση).

Προσοχή!

Αν θέλουμε ο κατάλογος ενεργών σχημάτων που δημιουργήσαμε να γίνει μόνιμος, να ξαναεμφανιστεί όταν θα ανοίξουμε το ίδιο σχέδιο και να μπορούμε να εισάγουμε τα σχήματά του σε άλλα σχέδια, θα πρέπει υποχρεωτικά να τον αποθηκεύσουμε. Αν δεν τον αποθηκεύσουμε, κλείνοντας το σχέδιό μας, θα εμφανιστεί ένα παράθυρο ρωτώντας μας αν θέλουμε να τον αποθηκεύσουμε. Κατάλογος που δεν έχει αποθηκευτεί είναι σαν να μην έχει δημιουργηθεί!
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Ακόμα και την τελευταία στιγμή μπορούμε να τον αποθηκεύσουμε, αρκεί να επιλέξουμε ναι ('Yes') στο παράθυρο με την ερώτηση της αποθήκευσης.

7 Εκτύπωση

Εκτός από τον σχεδιασμό και την αποθήκευση ενός σχεδίου, άλλη μία λειτουργία, η εκτύπωση ενός σχεδιαστικού προγράμματος, ανήκει στις βασικές. Ίσως να είναι και η κυριότερη, αφού πρόκειται για το 'χειροπιαστό' δείγμα της δουλειάς μας. 

7.1 [image: image167.png]


Η εκτύπωση

Η εντολή της εκτύπωσης XE "εκτύπωση"  βρίσκεται στο μενού File. Στην βασική γραμμή εργαλείων υπάρχει και για την εκτύπωση ένα εικονίδιο.

Με όποιον τρόπο και αν ξεκινήσουμε την διαδικασία της εκτύπωσης, ανοίγει ένα παράθυρο με ορισμένες επιλογές:

1. Εκτυπωτής

2. Ρυθμίσεις εκτυπωτή

3. Αριθμός αντιγράφων
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Για να πάρουμε σωστά σε χαρτί ό,τι έχουμε σχεδιάσει, θα πρέπει να έχουμε κάνει σωστά ορισμένες ρυθμίσεις. Η βασικότερη είναι το μέγεθος του χαρτιού (File > Page Setup).

8 ΕΥΡΕΤΗΡΙΟ
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